Digital Still Camera

Cyber-shot Handbook

DSC-T20/T25

Before operating the unit, please read this Handbook, “Instruction Manual” and “Cyber-shot Step-up Guide” thoroughly, and retain them for future reference.
Notes on using your camera

Types of “Memory Stick” that can be used (not supplied)
The IC recording medium used by this camera is a “Memory Stick Duo”. There are two types of “Memory Stick”.

“Memory Stick Duo”: you can use a “Memory Stick Duo” with your camera.

“Memory Stick”: you cannot use a “Memory Stick” with your camera.

Other memory cards cannot be used.
- For details on “Memory Stick Duo”, see page 111.

When using a “Memory Stick Duo” with “Memory Stick” compatible equipment
You can use the “Memory Stick Duo” by inserting it into the Memory Stick Duo Adaptor (not supplied).

Notes on the battery pack
- If you do not intend to use the battery pack for a long time, use up the existing charge and remove it from your camera, then store it in a cool, dry place. This is to maintain the battery pack functions.
- For details on the usable battery pack, see page 113.

Carl Zeiss lens
This camera is equipped with a Carl Zeiss lens which is capable of reproducing sharp images with excellent contrast. The lens for this camera has been produced under a quality assurance system certified by Carl Zeiss in accordance with the quality standards of Carl Zeiss in Germany.

Notes on the LCD screen and lens
- The LCD screen is manufactured using extremely high-precision technology so over 99.99% of the pixels are operational for effective use. However, there may be some tiny black points and/or bright points (white, red, blue or green in color) that constantly appear on the LCD screen. These points are normal in the manufacturing process and do not affect the recording in any way.

- Exposing the LCD screen or the lens to direct sunlight for long periods may cause malfunctions. Be careful when placing the camera near a window or outdoors.

- Do not press against the LCD screen. The screen may be discolored and that may cause a malfunction.

- Images may trail across on the LCD screen in a cold location. This is not a malfunction.

- Be careful not to bump the lens, and be careful not to apply force to it.

The pictures used in this Handbook
The photographs used as examples of pictures in this Handbook are reproduced images, and are not actual images shot using this camera.
# Table of contents

Notes on using your camera .................................................................2
Basic techniques for better images .......................................................7
  Focus – Focusing on a subject successfully ........................................7
  Exposure – Adjusting the light intensity ..........................................8
  Color – On the effects of lighting ....................................................9
  Quality – On “image quality” and “image size” .................................10
Identifying parts ..............................................................................12
Indicators on the screen .................................................................14
Changing the screen display .............................................................18
Using the internal memory ...............................................................19

## Basic Operations

Shooting images easily (Auto adjustment mode) ...............................20
Viewing images ...............................................................................24
Deleting images ..............................................................................26
Learning the various functions – HOME/Menu .................................28
Menu items .....................................................................................31

## Using functions for shooting

**Switching the shooting mode** ....................................................32
**Shooting images using Scene Selection** .....................................33
**Shooting menu** .........................................................................35
  Scene Selection: Using Scene Selection
  Image Size: Selecting the image size
  Face Detection: Detecting the face of subject
  REC Mode: Selecting the continuous shooting method
  Color Mode: Changing the vividness of the image or adding special effects
  ISO: Selecting a luminous sensitivity
  EV: Adjusting the light intensity
  Metering Mode: Selecting the metering mode
  Focus: Changing the focus method
  White Bal: Adjusting the color tones
  Flash Level: Adjusting the amount of flash light
  Red Eye Reduction: Reducing the red-eye phenomenon
  SteadyShot: Selecting the anti-blur mode
  SETUP: Selecting the shooting settings
Using functions for viewing

Playing back images from the HOME screen............................. 46
- (Single Image): Playing back a single image
- (Index Display): Playing back a list of images
- (Slide Show): Playing back a series of images

Viewing menu ............................................................................. 49
- (Delete): Deleting images
- (Slide Show): Playing back a series of images
- (Retouch): Retouching still images after shooting
- (Protect): Preventing accidental erasure
- DPOF: Adding a Print order mark
- (Print): Printing images using a printer
- (Rotate): Rotating a still image
- (Select Folder): Selecting the folder for viewing images

Customizing the settings

Customizing the Manage Memory feature and the Settings ....... 55
- Manage Memory............................................................................. 57
- Memory Tool – Memory Stick Tool ............................................. 57
- Format
- Create REC.Folder
- Change REC.Folder
- Copy
- Memory Tool – Internal Memory Tool ........................................ 59
- Format

Settings.......................................................................................... 60
- Main Settings – Main Settings 1 ................................................. 60
- Beep
- Initialize
- Function Guide
- Main Settings – Main Settings 2 ................................................. 61
- USB Connect
- Video Out
- COMPONENT
- Shooting Settings – Shooting Settings 1 ................................. 63
- AF Illuminator
- AF Mode
- Grid Line
- Digital Zoom
- Shooting Settings – Shooting Settings 2 ..................................... 65
- Auto Orientation
- Auto Review
- Clock Settings............................................................................. 66
- Language Setting......................................................................... 67
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewing images on a TV</td>
<td>68</td>
</tr>
<tr>
<td>Connecting your camera to a TV with cable for multi-use terminal</td>
<td>68</td>
</tr>
<tr>
<td>Connecting your camera to an HD TV</td>
<td>69</td>
</tr>
<tr>
<td>Enjoying your Windows computer</td>
<td>71</td>
</tr>
<tr>
<td>Installing the software (supplied)</td>
<td>73</td>
</tr>
<tr>
<td>Copying images to your computer</td>
<td>74</td>
</tr>
<tr>
<td>Viewing image files stored on a computer with your camera (using a “Memory Stick Duo”)</td>
<td>80</td>
</tr>
<tr>
<td>Using the “Picture Motion Browser” (supplied)</td>
<td>81</td>
</tr>
<tr>
<td>Using the “Music Transfer” (supplied)</td>
<td>87</td>
</tr>
<tr>
<td>Using your Macintosh computer</td>
<td>88</td>
</tr>
<tr>
<td>Printing still images</td>
<td>90</td>
</tr>
<tr>
<td>How to print still images</td>
<td>90</td>
</tr>
<tr>
<td>Printing images directly using a PictBridge compliant printer</td>
<td>91</td>
</tr>
<tr>
<td>Printing at a shop</td>
<td>94</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>96</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>96</td>
</tr>
<tr>
<td>Warning indicators and messages</td>
<td>107</td>
</tr>
<tr>
<td>Others</td>
<td></td>
</tr>
<tr>
<td>To use your camera abroad — Power sources</td>
<td>110</td>
</tr>
<tr>
<td>On the “Memory Stick”</td>
<td>111</td>
</tr>
<tr>
<td>On the battery pack</td>
<td>113</td>
</tr>
<tr>
<td>On the battery charger</td>
<td>114</td>
</tr>
<tr>
<td>Index</td>
<td>115</td>
</tr>
<tr>
<td>-------</td>
<td>----</td>
</tr>
</tbody>
</table>

Index ......................................................................................................................... 115
Basic techniques for better images

**Focus**

When you press the shutter button halfway down, the camera adjusts the focus automatically (Auto Focus). Remember to press the shutter button only halfway down.

Press the shutter button fully down suddenly. Press the shutter button halfway down. AE/AF lock indicator flashing ➔ lit/beeps. Then press the shutter button fully down.

To shoot a still image difficult to focus on → [Focus] (page 41)
If the image looks blurred even after focusing, it may be because of camera shake. → See “Hints for preventing blur” (as follows).

**Hints for preventing blur**

Hold the camera steady, keeping your arms at your side. It is recommended to lean against a tree or a building nearby to steady yourself. Shooting with a 2-second delay self-timer, or using a tripod is also effective. Use the flash when you shoot under a low light condition.
Basic techniques for better images

**Exposure Adjusting the light intensity**

You can create various images by adjusting the exposure and the ISO sensitivity. Exposure is the amount of light that the camera will receive when you release the shutter.

**Exposure**

- **Shutter speed** = Length of time the camera receives light
- **Aperture** = Size of the opening allowing light to pass through
- **ISO sensitivity (Recommended Exposure Index)** = Recording sensitivity

**Overexposure**

= too much light
Whitish image

The exposure is automatically set to the proper value in the auto adjustment mode. However, you can adjust it manually using the functions below.

**Correct exposure**

**Underexposure**

= too little light
Darker image

**Adjusting EV:**

Allows you to adjust the exposure determined by the camera (page 39).

**Metering Mode:**

Allows you to change the part of the subject to be measured to determine the exposure (page 40).

**Adjusting ISO sensitivity (Recommended Exposure Index)**

ISO sensitivity is a speed rating for recording media that incorporates an image sensor that receives light. Even when the exposure is the same, images differ depending on the ISO sensitivity.

To adjust the ISO sensitivity, see page 39.

**High ISO sensitivity**

Records a bright image even when shooting in a dark location. However, the image tends to become noisy.

**Low ISO sensitivity**

Records a smoother image. However, when the exposure is insufficient, the image may become darker.
Basic techniques for better images

**Color**

*On the effects of lighting*

The apparent color of the subject is affected by the lighting conditions.

**Example: The color of an image affected by light sources**

<table>
<thead>
<tr>
<th>Weather/lighting</th>
<th>Daylight</th>
<th>Cloudy</th>
<th>Fluorescent</th>
<th>Incandescent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characteristics of light</td>
<td>White (standard)</td>
<td>Bluish</td>
<td>Green-tinged</td>
<td>Reddish</td>
</tr>
</tbody>
</table>

The color tones are adjusted automatically in the auto adjustment mode. However, you can adjust color tones manually with [White Bal] (page 43).
A digital image is made up of a collection of small dots called pixels. If it contains a large number of pixels, the picture becomes large, it takes up more memory, and the image is displayed in fine detail. “Image size” is shown by the number of pixels. Although you cannot see the differences on the screen of the camera, the fine detail and data processing time differ when the image is printed or displayed on a computer screen.

### Description of the pixels and the image size

1. **Image size: 8M**
   
   3264 pixels × 2448 pixels = 7,990,272 pixels

2. **Image size: VGA**
   
   640 pixels × 480 pixels = 307,200 pixels

### Selecting the image size for use

<table>
<thead>
<tr>
<th>Image size</th>
<th>Guidelines</th>
<th>No. of images</th>
<th>Printing</th>
</tr>
</thead>
<tbody>
<tr>
<td>8M (3264×2448)</td>
<td>For prints up to A3(11×17&quot;)</td>
<td>Less</td>
<td>Fine</td>
</tr>
<tr>
<td>3:2¹ (3264×2176)</td>
<td>Shoot in 3:2 aspect ratio</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5M (2592×1944)</td>
<td>For prints up to A4(8.5×11&quot;)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3M (2048×1536)</td>
<td>For prints up to 10×15 cm (4×6&quot;) or 13×18 cm(5×7&quot;)</td>
<td>More</td>
<td>Rough</td>
</tr>
<tr>
<td>VGA (640×480)</td>
<td>Shoot at a small image size for e-mail attachment</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16:9² (1920×1080)</td>
<td>Shoot in HDTV aspect ratio</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1) Images are recorded in 3:2 aspect ratio, same as photograph printing paper or postcards, etc.
2) Both edges of the image may be cut off when printing (page 104).
Basic techniques for better images

The larger the image size, the higher the image quality.
The more frames per second you played back, the smoother playback can be.

<table>
<thead>
<tr>
<th>Movie image size</th>
<th>Frame/Second</th>
<th>Usage guidelines</th>
</tr>
</thead>
<tbody>
<tr>
<td>640(Fine) (640×480)</td>
<td>Approx. 30</td>
<td>Shoot high quality movie for display on TV</td>
</tr>
<tr>
<td>640(Standard) (640×480)</td>
<td>Approx. 17</td>
<td>Shoot standard quality movie for display on TV</td>
</tr>
<tr>
<td>320 (320×240)</td>
<td>Approx. 8</td>
<td>Shoot at a small size for email attachment</td>
</tr>
</tbody>
</table>
Identifying parts

See the pages in parentheses for details of operation.

1 Shutter button (20)
2 Flash (21)
3 AF illuminator (63)/Self-timer lamp (23)
4 Lens
5 Lens cover

1 POWER button
2 POWER lamp
3 Speaker
4 (Playback) button (24)
5 LCD screen (18)
6 Microphone
7 For shooting: Zoom (W/T) button (21)
   For viewing: (Playback zoom) button/ (Index) button (24)
8 MENU button (30)
9 Battery/“Memory Stick Duo” cover
10 Hook for wrist strap
11 Control button
   Menu on: ▲/▼/◄/►/● (30)
   Menu off: DISP/ (18, 21-23)
12 HOME button (28)
13 Access lamp
14 “Memory Stick Duo” slot
15 Battery insertion slot
16 Battery eject lever
Identifying parts

17 Multi connector (bottom)
Used in the following situations:
• Making a USB connection between the camera and the computer.
• Making a connection to audio/video input jacks on a TV.
• Making a connection to a PictBridge compliant printer.

18 Tripod receptacle (bottom)
• Use a tripod with a screw length of less than 5.5 mm (7/32 inch). You will be unable to firmly secure the camera to tripods having screws longer than 5.5 mm (7/32 inch), and may damage the camera.
Indicators on the screen

Each time you press ▲ (DISP) button, the display changes (page 18). See the pages in parentheses for details of operation.

When shooting still images

When shooting movies

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>📷</td>
<td>Battery remaining</td>
</tr>
<tr>
<td>⚡️</td>
<td>Low battery warning (107)</td>
</tr>
<tr>
<td>📷-pages</td>
<td>Image size (35)</td>
</tr>
<tr>
<td>📷-pages</td>
<td>Shooting mode (Scene Selection) (32)</td>
</tr>
<tr>
<td>📷-pages</td>
<td>Shooting mode (Program) (32)</td>
</tr>
<tr>
<td>📷-pages</td>
<td>White balance (43)</td>
</tr>
<tr>
<td>📷-pages</td>
<td>Recording mode (37)</td>
</tr>
<tr>
<td>📷-pages</td>
<td>Metering mode (40)</td>
</tr>
<tr>
<td>📷-pages</td>
<td>Face Detection (36)</td>
</tr>
<tr>
<td>📷-pages</td>
<td>SteadyShot (45)</td>
</tr>
<tr>
<td>📷-pages</td>
<td>Vibration warning</td>
</tr>
<tr>
<td>📷-pages</td>
<td>Indicates vibration may prevent you from shooting clear images due to insufficient lighting. Even if the vibration warning appears, you can still shoot images. However, we recommend that you turn on the anti-blur function, using the flash for better lighting or using a tripod or other means to stabilize the camera (page 7).</td>
</tr>
<tr>
<td>📷-pages</td>
<td>Self-timer (23)</td>
</tr>
<tr>
<td>📷-pages</td>
<td>Zoom scaling (21, 64)</td>
</tr>
<tr>
<td>📷-pages</td>
<td>Color mode (38)</td>
</tr>
</tbody>
</table>
### Indicators on the screen

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0m</td>
<td>Focus preset distance (41)</td>
</tr>
<tr>
<td>●</td>
<td>AE/AF lock (20)</td>
</tr>
<tr>
<td>Standby REC</td>
<td>Standby/Recording a movie</td>
</tr>
<tr>
<td>ISO400</td>
<td>ISO number (39)</td>
</tr>
</tbody>
</table>
| NR      | NR slow shutter  
  - When the shutter speed drops below a certain speed in low light conditions, the NR (Noise Reduction) slow shutter function activates automatically to reduce the picture noise. |
| 125     | Shutter speed |
| F3.5    | Aperture value |
| +2.0EV  | Exposure Value (39) |
| 00:00:12 | Recording time |
| ![AF range finder frame indicator](image) | AF range finder frame indicator (41) |
| ![Macro/Close Focus](image) | Macro/Close Focus (22) |
| ![Recording Media](image) | Recording Media |
| ![Recording folder](image) | Recording folder (57)  
  - This does not appear when using internal memory. |
| 96      | Remaining number of recordable images |
| 00:00:00 | Remaining recordable time |
| ![AF illuminator](image) | AF illuminator (63) |
| ![Red-eye reduction](image) | Red-eye reduction (45) |
| ![Flash mode](image) | Flash mode (21) |
| ![Flash charging](image) | Flash charging |

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>C:32:00</td>
<td>Self-diagnosis display (107)</td>
</tr>
<tr>
<td>+</td>
<td>Spot metering cross hair (40)</td>
</tr>
<tr>
<td><img src="image" alt="AF range finder frame" /></td>
<td>AF range finder frame (41)</td>
</tr>
<tr>
<td><img src="image" alt="Histogram" /></td>
<td>Histogram (18)</td>
</tr>
</tbody>
</table>

---

**Note:** Details on page 15 include additional information and diagrams related to the indicators on the screen, such as the display of recording media, recording folder, remaining number of images, and various focus and exposure settings.
Indicators on the screen

When playing back still images

1  Display | Indication
- Battery remaining
- Image size (35)
- Protect (52)
- Volume (24)
- Print order (DPOF) mark (94)
- PictBridge connecting (92)
- Zoom scaling (24)
- PictBridge connecting (93)

2  Display | Indication
- Playback (24)
- Playback bar
- Counter
- Folder-file number (54)
- Recorded date/time of the playback image
- Guide to play back images
- Select images
- Adjust volume
- Histogram (18)
  • appears when histogram display is disabled.

Do not disconnect the cable for multi-use terminal while the icon is displayed.
## Indicators on the screen

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎥</td>
<td>Playback Media</td>
</tr>
</tbody>
</table>
| 📣.deep| Playback folder (54)  
  • This does not appear when using internal memory. |
| 8/8 12/12 | Image number/Number of images recorded in selected folder |
| 🔄 ▶️ ◀️ | Change folder (54)  
  • This does not appear when using internal memory. |
| ◎ ◎     | Metering mode (40) |
| 🔍      | Flash |
| AWB ☀️ | White balance (43) |
| ▶️ ⬅️ ▶️ | Self-diagnosis display (107) |
| ISO400  | ISO number (39) |
| +2.0EV  | Exposure Value (39) |
| 500     | Shutter speed |
| F3.5    | Aperture value |
Changing the screen display

Each time you press the \( \Delta \) (DISP) button, the display changes as follows.

- **Brightness of LCD backlight up**
- **Histogram on**
- **Indicators off**
- **Indicators on**

A histogram is a graph showing the brightness of an image. Press \( \Delta \) (DISP) repeatedly to display the histogram inside the screen. The graph display indicates a bright image when skewed to the right side, and a dark image when skewed to the left side.

- **Number of pixels**
- **Brightness**

- If you view images in bright outside light, adjust the brightness of the LCD backlight up. However, the battery power may decrease faster under such condition.
- When the camera is connected to a TV, the display switches from Histogram on to Indicators off and then to Indicators on.
- The histogram does not appear in the following situations:
  - While shooting
    - When the menu is displayed.
    - When recording movies
  - During playback
    - When the menu is displayed.
    - In index mode
    - When you are using playback zoom.
    - When you are rotating still images.
    - During playback of movies
  - A large difference in the histogram displayed when shooting and during playback may occur when:
    - The flash strobes.
    - The shutter speed is slow or high.
  - The histogram may not appear for images recorded using other cameras.

- Adjusting EV (Exposure Value) by displaying a histogram

- The histogram also appears when playing back a single image, but you cannot adjust the exposure.
Using the internal memory

The camera has approximately 31 MB of internal memory. This memory is not removable. Even when there is no “Memory Stick Duo” inserted in the camera, you can record images using this internal memory.

- Movies with the image size set to [640(Fine)] cannot be recorded using the internal memory.

When a “Memory Stick Duo” is inserted

[Recording]: Images are recorded on the “Memory Stick Duo”.
[Playback]: Images on the “Memory Stick Duo” are played back.
[Menu, Settings, etc.]: Various functions can be performed on images on the “Memory Stick Duo”.

When there is no “Memory Stick Duo” inserted

[Recording]: Images are recorded using the internal memory.
[Playback]: Images stored in the internal memory are played back.
[Menu, Settings, etc.]: Various functions can be performed on images in the internal memory.

On image data stored in the internal memory

We recommend that you copy (back up) data without error using one of the following methods.

To copy (back up) data on a “Memory Stick Duo”

Prepare a “Memory Stick Duo” with a capacity of 32 MB or more, then perform the procedure explained in [Copy] (page 58).

To copy (back up) data on a hard disk of your computer

Perform the procedure on pages 74 to 77 without a “Memory Stick Duo” inserted in the camera.

- You cannot copy image data on a “Memory Stick Duo” to the internal memory.
- By connecting the camera and a computer with a cable for multi-use terminal, you can copy data stored in the internal memory to a computer. However you cannot copy data on a computer to the internal memory.
Basic Operations

Shooting images easily (Auto adjustment mode)

1 Slide the lens cover downward.

2 Hold the camera steady, keeping your arm at your side.

3 Shoot with the shutter button.

   ① Press and hold the shutter button halfway down to focus.
       The (AE/AF lock) indicator (green) flashes, a beep sounds, the indicator stops flashing and remains lit.
   ② Press the shutter button fully down.
       The shutter sounds.
Shooting movies
Press HOME button and select (Shooting) and then select [Movie Mode] (page 28.)

If you shoot a still image of a subject that is difficult to focus on
- The shortest shooting distance is approx. 50 cm (19 3/4 inches). Shoot in the close-up (Macro) mode or Close Focus mode (page 22) when you shoot a subject closer than the shooting distance.
- When the camera cannot focus on the subject automatically, the AE/AF lock indicator changes to flashing slowly and the beep does not sound. In addition, the AF range finder frame disappears. Recompose the shot and focus again.

Subjects difficult to focus on are:
- Distant from the camera and dark
- The contrast between the subject and its background is poor.
- Seen through glass
- Moving fast
- Reflective light or with a lustrous finish
- Flashing
- Backlit

Using the zoom
Press  to zoom, press  to undo the zoom.
- When the zoom scale exceeds 3x, the camera uses the Digital Zoom function.
  For details on the [Digital Zoom] settings and the image quality, see page 64.
- The camera zooms slowly while shooting a movie.

Flash (Selecting a flash mode for still images)
Press ➤ ( ) on the control button repeatedly until the desired mode is selected.

(No Indicator): Flash Auto
- Strobes when there is insufficient light or backlight (default setting)
$\downarrow$: Flash forced on
$$\downarrow$$: Slow synchro (Flash forced on)
- The shutter speed is slow in a dark place to clearly shoot the background that is out of flash light.
$$\downarrow$$: Flash forced off
- The flash strobes twice. The first time is to adjust the light quantity.
- While charging the flash,  is displayed.
Macro/Close Focus (Shooting close-up)

Press ◀ (⿷) on the control button repeatedly until the desired mode is selected.

(No Indicator): Macro Off

⿷: Macro On (W side: Approx. 8 cm or farther (3 1/4 inches or farther), T side: Approx. 25 cm or farther (9 7/8 inches or farther))

⿸: Close focus enabled (Locked to the W side: Approx. 1 to 20 cm (13/32 to 7 7/8 inches))

Macro

• Setting the zoom all the way to the W side is recommended.
• The in-focus range becomes narrow, and the complete subject may not entirely be in focus.
• The Auto Focus speed drops.

Close Focus

• Use this mode to shoot at even closer distances than ♂ (Macro) recording.
• The optical zoom is locked to the W side and cannot be used.
• You cannot shoot images in the Burst or Bracket mode (page 37.)
• You cannot use the Face Detection feature when you shoot images in the Close Focus mode.
• When you press the zoom button, the image is enlarged using the digital zoom.
Using the self-timer

Press ▼ (__) on the control button repeatedly until the desired mode is selected.

(No Indicator): Not using the self-timer

(10): Setting the 10-second delay self-timer

(2): Setting the 2-second delay self-timer

Press the shutter button, the self-timer lamp flashes, and a beep sounds until the shutter operates.

To cancel, press ▼ (__) again.

- Use the 2-second delay self-timer to prevent blur of an image made by the shaking of the camera when pressing the shutter button.
Viewing images

1 Press the (Playback) button.
   If you press (Playback) when the camera is powered off, the camera is turned on automatically and set to playback mode. To set to the shooting mode, press (Playback) again.

2 Select an image with ◀/▶ on the control button.
   Movie:
   Press ● to play back a movie. (Press ● again to stop playback.)
   Press ◀/▶ to rewind/fast forward. (Press ● to return to normal playback.)
   Press ▼ to display the volume control screen, then press ◀/▶ to adjust the volume.
   • Movies with the image size [320] are displayed a size smaller.

 khảo/s To view an enlarged image (playback zoom)
Press khảo while displaying a still image.
To undo the zoom, press khảo.
Adjust the portion: ▲/▼/◄/►
Cancel playback zoom: ●
• To store enlarged images: [Trimming] (page 51)
Viewing images

Viewing an index screen

Press  (Index) to display the index screen while a still image is displayed. Select an image with ▲/▼/◄/►. To return to the single image screen, press ●.

When there are a number of folders in the “Memory Stick Duo” inserted in the camera, select the folder selection bar with ◄, then select the desired folder with ▲/▼.

- You can also access the index screen by selecting [ Index Display] on the HOME screen.
- Each time you press  (Index), the number of pictures on the index screen changes.
Deleting images

1 Press the (Playback) button.

2 Press MENU while a single image or multiple images are displayed.

3 Select [Delete] with ▲ on the control button.

<table>
<thead>
<tr>
<th>Delete</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>[This Image]</td>
<td>[Multiple Images]</td>
<td>[All In This Folder]</td>
</tr>
<tr>
<td>▲/▼/◄/► button</td>
<td>▲/▼/◄/► button</td>
<td>▲/▼/◄/► button</td>
</tr>
</tbody>
</table>

4 Select the desired deletion method with ▲/▼/◄/► from among [This Image], [Multiple Images] and [All In This Folder], then press ●.

When you select [This Image]
Deletes the currently selected image.
Select [OK] with ▲, then press ●.
Deleting images

When you select [Multiple Images]
Selects and deletes multiple images at once.

1. Select the images you want to delete, then press .
   The (check mark) is checked in the checkbox of the image.

2. Press MENU.

3. Select [OK] with , then press .

When you select [All In This Folder]
Deletes all the images in the selected folder.
Select [OK] with , then press .

- When the index screen is displayed, you can delete all the images in the folder by selecting [Multiple Images] and moving the highlight to the folder bar with , then putting a checkmark in the checkbox of the folder.
Learning the various functions – HOME/Menu

Using the HOME screen

The HOME screen is the basic screen used for accessing the various functions you can access the HOME screen regardless of the shooting/viewing mode.

1. Press HOME to display the HOME screen.

2. Select a category with \( \wedge/\vee \) on the control button.

3. Select an item with \( \wedge/\vee \), then press \( \bullet \).

- You cannot display the HOME screen when a PictBridge connection or a USB connection is made.
- To switch to the shooting mode, press the shutter button halfway down.
## HOME screen items

Pressing the HOME button displays the following items. Details on the items are displayed on the screen by the guide.

<table>
<thead>
<tr>
<th>Category</th>
<th>Items</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Shooting</strong></td>
<td>Auto Adjustment (page 32)</td>
</tr>
<tr>
<td></td>
<td>Scene Selection (page 32)</td>
</tr>
<tr>
<td></td>
<td>Program Auto (page 32)</td>
</tr>
<tr>
<td></td>
<td>Movie Mode (page 32)</td>
</tr>
<tr>
<td><strong>View Images</strong></td>
<td>Single Image (page 46)</td>
</tr>
<tr>
<td></td>
<td>Index Display (page 46)</td>
</tr>
<tr>
<td></td>
<td>Slide Show (page 46)</td>
</tr>
<tr>
<td><strong>Printing, Other</strong></td>
<td>Print</td>
</tr>
<tr>
<td></td>
<td>Music Tool (page 87)</td>
</tr>
<tr>
<td></td>
<td>Download Music</td>
</tr>
<tr>
<td></td>
<td>Format Music</td>
</tr>
<tr>
<td><strong>Manage Memory</strong></td>
<td>Memory Tool</td>
</tr>
<tr>
<td></td>
<td>Memory Stick Tool (page 57)</td>
</tr>
<tr>
<td></td>
<td>Format</td>
</tr>
<tr>
<td></td>
<td>Change REC.Folder</td>
</tr>
<tr>
<td></td>
<td>Copy</td>
</tr>
<tr>
<td></td>
<td>Internal Memory Tool (page 59)</td>
</tr>
<tr>
<td></td>
<td>Format</td>
</tr>
<tr>
<td><strong>Settings</strong></td>
<td>Main Settings</td>
</tr>
<tr>
<td></td>
<td>Main Settings 1 (page 60)</td>
</tr>
<tr>
<td></td>
<td>Beep</td>
</tr>
<tr>
<td></td>
<td>Initialize</td>
</tr>
<tr>
<td></td>
<td>Main Settings 2 (page 61)</td>
</tr>
<tr>
<td></td>
<td>USB Connect</td>
</tr>
<tr>
<td></td>
<td>COMPONENT</td>
</tr>
<tr>
<td></td>
<td>Video Out</td>
</tr>
<tr>
<td><strong>Shooting Settings</strong></td>
<td>Shooting Settings 1 (page 63)</td>
</tr>
<tr>
<td></td>
<td>AF Illuminator</td>
</tr>
<tr>
<td></td>
<td>Grid Line</td>
</tr>
<tr>
<td></td>
<td>AF Mode</td>
</tr>
<tr>
<td></td>
<td>Digital Zoom</td>
</tr>
<tr>
<td></td>
<td>Shooting Settings 2 (page 65)</td>
</tr>
<tr>
<td></td>
<td>Auto Orientation</td>
</tr>
<tr>
<td></td>
<td>Auto Review</td>
</tr>
<tr>
<td><strong>Clock Settings</strong></td>
<td>Clock Settings (page 66)</td>
</tr>
<tr>
<td><strong>Language Setting</strong></td>
<td>Language Setting (page 67)</td>
</tr>
</tbody>
</table>
Learning the various functions – HOME/Menu

Using the menu items

1 Press MENU to display the menu.

- The menu can be displayed only when the camera is in shooting mode or playback mode.
- Different items are available depending on the selected mode.

2 Select the desired menu item with ▲/▼ on the control button.

- If the desired item is hidden, keep pressing ▲/▼ until the item appears on the screen.

3 Select a setting with ◀/▶.

- If the desired setting is invisible, keep pressing ◀/▶ until the setting appears on the screen.
- Press ● after selecting an item.

4 Press MENU to turn off the menu.
The available menu items vary depending on the camera mode. The shooting menu is available only in the shooting mode, and the viewing menu is available only in the playback mode. Also, different items are available depending on the selected shooting mode (such as Auto Adjustment, Scene Selection, Program Auto, Movie Mode) on the HOME screen or on the playback screen.

<table>
<thead>
<tr>
<th>Selected mode:</th>
<th>Auto Adjustment</th>
<th>Scene Selection</th>
<th>Program Auto</th>
<th>Movie Mode</th>
</tr>
</thead>
</table>

**Menu for shooting** (page 35)

- Scene Selection — — ✓ — —
- Image Size ✓ ✓ ✓ ✓ ✓
- Face Detection ✓ ✓* — —
- REC Mode ✓ ✓* ✓ —
- Color Mode — — ✓ ✓
- ISO — — ✓ —
- EV ✓ ✓ ✓ ✓
- Metering Mode — — ✓ ✓
- Focus — — ✓ ✓
- White Bal — ✓* ✓ ✓
- Flash Level — — ✓ —
- Red Eye Reduction ✓ ✓* ✓ —
- SteadyShot — ✓ ✓ ✓
- SETUP ✓ ✓ ✓ ✓

*The operation is limited according to the selected Scene Selection mode (page 34).

**Menu for viewing** (page 49)

- (Delete) ✓
- (Retouch) ✓
- DPOF ✓
- (Rotate) ✓
- (Slide Show) ✓
- (Protect) ✓
- (Print) ✓
- (Select Folder) ✓
Using functions for shooting

Switching the shooting mode

You can switch the shooting mode on the HOME screen.

Shooting modes:
There are three shooting modes available for still images: Auto Adjustment, Scene Selection, Program Auto; and there is one recording mode for movies. The default setting is Auto Adjustment.

To switch the shooting mode to other than Auto Adjustment, follow the procedure described below.

1. Press HOME to display HOME screen.
2. Select (Shooting) with / on the control button.
3. Select the desired mode with ▲/▼, then press .

AUTO : Auto Adjustment mode
Allows you to shoot still images with the setting adjusted automatically.

SCN : Scene Selection mode
Allows you to shoot with preset settings according to the scene (page 33).

PGM : Program Auto mode
Allows you to shoot with the exposure adjusted automatically (both the shutter speed and the aperture value). Also you can select various settings using the menu. (Refer to page 31 for details on the functions available.)

Movie Mode
Allows you to record movies with audio.
Shooting images using Scene Selection

Scene Selection modes

The following modes are predetermined to match the scene conditions.

- **High Sensitivity**
  - Allows you to shoot images without a flash under low light conditions, reducing blur.

- **Landscape**
  - Focuses only on a distant subject to shoot landscapes, etc.

- **Hi-Speed Shutter**
  - Allows you to shoot moving subjects outdoors or in other bright places.
    - The shutter speed becomes faster, so images shot in dark places become darker.

- **Soft Snap**
  - Allows you to shoot images with a softer atmosphere for portraits of people, flowers, etc.

- **Twilight Portrait***
  - Suitable for shooting portraits in dark places. Allows you to shoot sharp images of people in dark places without losing the dark atmosphere of the surroundings.

- **Twilight***
  - Allows you to shoot night scenes at far distance without losing the dark atmosphere of the surroundings.

- **Beach**
  - When shooting seaside or lakeside scenes, the blue of the water is clearly recorded.

- **Snow**
  - When shooting snowy scenes or other places where the whole screen appears white, use this mode to prevent sunken colors and record clear images.

- **Fireworks***
  - Allows you to record fireworks in all their splendor.

*When you shoot images using [Twilight Portrait], [Twilight] or [Fireworks] mode, the shutter speed is slower. To prevent a blurring, use of a tripod is recommended.*
Shooting images using Scene Selection

Functions that cannot be combined with Scene Selection

For shooting an image appropriately according to the scene condition, a combination of functions is determined by the camera. Some functions are not available, depending on the Scene Selection mode.

(✓: you can select the desired setting)

<table>
<thead>
<tr>
<th>Macro/Close Focus</th>
<th>Flash</th>
<th>Face Detection</th>
<th>Burst/Bracket</th>
<th>EV</th>
<th>White Bal</th>
<th>Red Eye Reduction</th>
<th>SteadyShot</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISO</td>
<td>✓/—</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>🏛️</td>
<td>✓/—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>🕒</td>
<td>✓/—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>🕒</td>
<td>—/—</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>🏛️</td>
<td>—/—</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>🕒</td>
<td>✓/—</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>🕒</td>
<td>✓/—</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>🕒</td>
<td>—/—</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
</tbody>
</table>

* [Flash] cannot be selected.
The functions in shooting mode using the MENU button are described below. For details on how to operate the menu, see page 30.

The available modes are indicated as shown below. You cannot select the mode displayed in grey.

<table>
<thead>
<tr>
<th>Available</th>
<th>Unavailable</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTO</td>
<td>SCN</td>
</tr>
</tbody>
</table>

Shooting mode (Auto Adjustment/Scene Selection/Program Auto) Movie Mode

The default settings are marked with ✓.

**Scene Selection: Using Scene Selection**

Select the still image shooting mode. Allows you to shoot with the preset settings according to the scene (Scene Selection) (page 33).

**Image Size: Selecting the image size**

For still images

| ✓ | [8M] | Selects image size for shooting still images. For details, see page 10. |
| | [6.2] |
| | [3M] |
| | [VGA] |
| | [16:9] |

For movie

| ✓ | [FINE] (Fine) | Selects image size for recording movies. For details, see page 10. |
| | [STD] (Standard) |
| | [320] |
Selects whether to use the Face Detect function or not.

<table>
<thead>
<tr>
<th>[ ] (On)</th>
<th>Detecting the faces of your subject will also adjust focus, strobe, exposure, white balance, and pre-strobe for red-eye reduction.</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ ] (Off)</td>
<td>Does not use Face Detection function.</td>
</tr>
</tbody>
</table>

- Available only for [Soft Snap] when you select the Scene Selection mode. In this case, the Face Detection mode is set to [On] as the default.
- Up to 8 faces in your subject can be detected. When you shoot images with [Soft Snap], the number of faces in your subject that can be detected will be limited to up to 2 faces.
- When more than one face is detected in your subject, the priority for the focus point is automatically given to one of the persons identified as the main subject by the camera.
- When you press and hold the shutter button halfway down to focus, the frame around the subject in focus changes to green. If the frame does not change to green, a subject at the same distance as the main subject is also in focus.
- Face Detection may fail, depending on the conditions under which it is used.
- When [Face Detection] is set to [On], AF Illuminator does not function.
Using functions for shooting

**Shooting menu**

For details on the operation page 30

**REC Mode: Selecting the continuous shooting method**

Selects whether the camera performs continuous shooting or not when you press the shutter button.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Normal)</td>
<td>Does not shoot continuously.</td>
</tr>
<tr>
<td>(Burst)</td>
<td>Records up to 100 images in succession when you press and hold down the shutter button.</td>
</tr>
<tr>
<td>BRK ±0.3EV</td>
<td>Records a series of three images with the exposure values automatically shifted (Exposure Bracket).</td>
</tr>
<tr>
<td>BRK ±0.7EV</td>
<td></td>
</tr>
<tr>
<td>BRK ±1.0EV</td>
<td></td>
</tr>
</tbody>
</table>

- The flash is set to (Flash forced off).
- You cannot shoot in the Exposure Bracket mode, when (Shooting) is set to [Auto Adjustment].
- The flash is set to (Flash forced off).

**On the Burst**
- When recording with the self timer, a series of a maximum of five images is recorded.
- The recording interval is approximately 0.46 second. The recording interval is longer, depending on the setting for the image size.
- When the battery level is low, or when the internal memory or “Memory Stick Duo” is full, the Burst stops.
- You may not be able to shoot images in the Burst mode depending on the Scene Selection mode (page 34).

**On the Exposure Bracket**
- The focus and white balance are adjusted for the first image, and these settings are also used for the other images.
- When the exposure is manually adjusted (page 39), the exposure is shifted based on the adjusted brightness.
- The recording interval is approximately 0.46 second.
- If the subject is too bright or too dark, you may be unable to shoot properly with the selected bracket step value.
- You may not be able to shoot images in the Exposure Bracket mode depending on the Scene Selection mode (page 34).
You can change the brightness of the image, accompanied by effects.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✅ □⁺ (Normal)</td>
<td><img src="image1.png" alt="Image" /> Set the image to bright and deep color.</td>
</tr>
<tr>
<td>⬤⁺ (Vivid)</td>
<td><img src="image2.png" alt="Image" /> Sets the image to bright and deep color.</td>
</tr>
<tr>
<td>⬤⁻ (Natural)</td>
<td><img src="image3.png" alt="Image" /> Sets the image to quiet color.</td>
</tr>
<tr>
<td>⭕⁻ (Sepia)</td>
<td><img src="image4.png" alt="Image" /> Sets the image to sepia color.</td>
</tr>
<tr>
<td>⭕⁺ (B &amp; W)</td>
<td><img src="image5.png" alt="Image" /> Sets the image to monochromatic color.</td>
</tr>
</tbody>
</table>

- You can select only [Normal], [B & W] or [Sepia] when shooting movies.
ISO: Selecting a luminous sensitivity

Selects a luminous sensitivity with units of ISO. The larger the number, the higher the sensitivity.

- For details on the ISO sensitivity, see page 8.
- Note that the image tends to become noisier as the ISO sensitivity number increases.
- [ISO] is set to [Auto] in the Scene Selection mode.
- When shooting under brighter conditions, the camera automatically increases its tone reproduction and helps prevent images to become whitish (excluding when [ISO] is set to [80]).

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISO AUTO (Auto)</td>
<td>Select a large number when shooting in dark locations or shooting a subject moving at high speed, or select a small number to obtain high image quality.</td>
</tr>
<tr>
<td>ISO 80</td>
<td></td>
</tr>
<tr>
<td>ISO 100</td>
<td></td>
</tr>
<tr>
<td>ISO 200</td>
<td></td>
</tr>
<tr>
<td>ISO 400</td>
<td></td>
</tr>
<tr>
<td>ISO 800</td>
<td></td>
</tr>
<tr>
<td>ISO 1600</td>
<td></td>
</tr>
<tr>
<td>ISO 3200</td>
<td></td>
</tr>
</tbody>
</table>

EV: Adjusting the light intensity

Manually adjusts the exposure.

- For the details on the exposure, see page 8.
- The compensation value can be set in 1/3EV increments.
- If a subject is being shot in extremely bright or dark conditions, or the flash is used, the exposure adjustment may not be effective.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>−2.0EV</td>
<td>Toward −: Darkens an image.</td>
</tr>
<tr>
<td>0EV</td>
<td>The exposure is determined automatically by the camera.</td>
</tr>
<tr>
<td>+2.0EV</td>
<td>Toward +: Brightens an image.</td>
</tr>
</tbody>
</table>
Selects the metering mode that sets which part of the subject to measure to determine the exposure.

<table>
<thead>
<tr>
<th>Metering Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑ (Multi)</td>
<td>Divides into multiple regions and measures each region. The camera determines a well-balanced exposure (Multi-pattern metering).</td>
</tr>
<tr>
<td>(Center)</td>
<td>Measures the center of the image, and determines the exposure based on the brightness of the subject there (Center-weighted metering).</td>
</tr>
<tr>
<td>(Spot)</td>
<td>Measures only a part of the subject (Spot metering). This function is useful when the subject is backlit or when there is strong contrast between the subject and the background.</td>
</tr>
</tbody>
</table>

- For the details on the exposure, see page 8.
- When using spot metering or center-weighted metering, setting [Focus] to [Center AF] is recommended to focus on the metering position (page 41).
You can change the focus method. Use the menu when it is difficult to get the proper focus in auto focus mode.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Focus Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ (Multi AF)</td>
<td>Focuses on a subject in all ranges of the finder frame automatically.</td>
</tr>
<tr>
<td></td>
<td>• This mode is useful when the subject is not in the center of the frame.</td>
</tr>
<tr>
<td><img src="image1.png" alt="AF range finder frame" /></td>
<td>AF range finder frame (Only for still image)</td>
</tr>
<tr>
<td><img src="image2.png" alt="AF range finder frame indicator" /></td>
<td>AF range finder frame indicator</td>
</tr>
<tr>
<td>🟢 (Center AF)</td>
<td>Focuses on a subject in the center of the finder frame automatically.</td>
</tr>
<tr>
<td></td>
<td>• Using together with the AF lock function lets you shoot in the desired image composition.</td>
</tr>
<tr>
<td><img src="image1.png" alt="AF range finder frame" /></td>
<td>AF range finder frame</td>
</tr>
<tr>
<td><img src="image2.png" alt="AF range finder frame indicator" /></td>
<td>AF range finder frame indicator</td>
</tr>
<tr>
<td>🟡 (Spot AF)</td>
<td>Focuses on an extremely small subject or a narrow area automatically.</td>
</tr>
<tr>
<td></td>
<td>• Using together with the AF lock function lets you shoot in the desired image composition. Hold the camera steady not to misalign the subject and the AF range finder frame.</td>
</tr>
<tr>
<td><img src="image1.png" alt="AF range finder frame" /></td>
<td>AF range finder frame</td>
</tr>
<tr>
<td><img src="image2.png" alt="AF range finder frame indicator" /></td>
<td>AF range finder frame indicator</td>
</tr>
</tbody>
</table>
Shooting menu

For details on the operation page 30

<table>
<thead>
<tr>
<th>Distance</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5 m</td>
<td>Focuses on the subject using a previously set distance to the subject. (Focus preset)</td>
</tr>
<tr>
<td>1.0 m</td>
<td>• When shooting a subject through a net or through window glass, it is difficult to get the proper focus in auto focus mode. In these cases, use of [Focus] is convenient.</td>
</tr>
<tr>
<td>3.0 m</td>
<td></td>
</tr>
<tr>
<td>7.0 m</td>
<td></td>
</tr>
<tr>
<td>∞ (unlimited distance)</td>
<td></td>
</tr>
</tbody>
</table>

• AF stands for Auto Focus.
• Distance setting information in [Focus preset] is approximate. If you point the lens up or down, the error increases.
• When you use Digital Zoom or AF illuminator, the normal AF range finder frame is disabled and a new AF range finder frame is displayed by a dotted line. In this case, the priority of AF movement is given to subjects around the center of the frame.

 archivo

If the subject is out of focus
When shooting with the subject at the edge of the frame (or the screen), or when using [Center AF] or [Spot AF], the camera may not focus on a subject at the edge of the frame.

In such cases, do as follows.

① Recompose the shot so that the subject is centered in the AF range finder, and press the shutter button halfway down to focus on the subject (AF lock).

![AF range finder frame](image)

As long as you do not press the shutter button fully down, you can retry the procedure as many times as you want.

② When the AE/AF lock indicator stops flashing and remains on, return to the fully composed shot, and press the shutter button fully down.
**White Bal: Adjusting the color tones**

Adjusts the color tones according to the lighting condition in a situation, for example, when the colors of an image look strange.

<table>
<thead>
<tr>
<th><strong>WB</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>(Auto)</strong></td>
<td>Adjusts the White Balance automatically.</td>
</tr>
<tr>
<td><strong>(Daylight)</strong></td>
<td>Adjusts for outdoors conditions on a fine day, evening views, night scenes, neon signs, fireworks, etc.</td>
</tr>
<tr>
<td><strong>(Cloudy)</strong></td>
<td>Adjusts for a cloudy sky or a shady location.</td>
</tr>
<tr>
<td><strong>(Fluorescent Light 1)/(Fluorescent Light 2)/(Fluorescent Light 3)</strong></td>
<td>Fluorescent Light 1: Adjust for white fluorescent lighting. Fluorescent Light 2: Adjust for natural white fluorescent lighting. Fluorescent Light 3: Adjust for day white fluorescent lighting.</td>
</tr>
<tr>
<td><strong>(Incandescent)</strong></td>
<td>Adjusts for places under incandescent lamp, or under bright lighting, such as in a photo studio.</td>
</tr>
</tbody>
</table>
Adjusts for the flash conditions.
- You cannot select this item when shooting movies.

For details on the white balance, see page 9.
Under fluorescent lights that flicker, the white balance function may not work correctly even though you select [Fluorescent Light 1], [Fluorescent Light 2], [Fluorescent Light 3].
Some options are not available depending on the Scene Selection mode (page 34).

Flash Level: Adjusting the amount of flash light

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>¥- (-)</td>
<td>Toward –: Makes the flash level lower.</td>
</tr>
<tr>
<td>✔ ¥0 (Normal)</td>
<td></td>
</tr>
<tr>
<td>¥+ (+)</td>
<td>Toward +: Makes the flash level higher.</td>
</tr>
</tbody>
</table>

To change flash mode, see page 21.
Shooting menu

For details on the operation page 30

Red Eye Reduction: Reducing the red-eye phenomenon

The flash strobes two or more times before shooting to reduce the red-eye phenomenon when using the flash.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Auto)</td>
<td>When [Face Detection] is set to [On], the flash strobes automatically to reduce the red-eye phenomenon.</td>
</tr>
<tr>
<td>(On)</td>
<td>The flash always strobes to reduce the red-eye phenomenon.</td>
</tr>
<tr>
<td>(Off)</td>
<td>Does not use Red Eye Reduction.</td>
</tr>
</tbody>
</table>

- Because it takes about a second until the shutter clicks, hold the camera firmly to prevent the effects of vibration. Also, do not let the subject move.
- Red-eye reduction may not produce the desired effects depending on individual differences, the distance to the subject, if the subject does not see the pre-strobe, or other conditions. In such a case, you can correct the red-eye phenomenon using [Retouch] in the viewing menu after shooting (page 49).
- This setting is not available depending on the Scene Selection mode (page 34).
- If you set [Face Detection] to [Off], the Red Eye Reduction does not work, even when you select [Auto].

SteadyShot: Selecting the anti-blur mode

Selects the anti-blur mode.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Shooting)</td>
<td>Activates the anti-blur function when pressing the shutter button halfway down.</td>
</tr>
</tbody>
</table>
| (Continuous) | Always activates the anti-blur function. You can stabilize images even when zooming up a far subject.  
- Battery consumption is faster than in [Shooting] mode. |
| (Off)    | Does not use anti-blur mode. |

- When [Auto Adjustment] mode is selected, [SteadyShot] is set to [Shooting].
- For movies, the options are limited to [Continuous] and [Off].
  The default setting is set to [Continuous].
- The anti-blur function may not work properly in the following cases.
  - When camera shake is too strong
  - When the shutter speed is slow, for example, shooting night scenes

SETUP: Selecting the shooting settings

Select the settings for the shooting function. This items appearing in this menu are same ones as those in (Shooting Settings) on the HOME screen. See page 29.
You can playback images using the HOME screen.

1. Press HOME.
2. Select (View Images) with ▼/▲ on the control button.
3. Select the desired viewing method with ▲/▼.

### (Single Image): Playing back a single image

Displays the image shot last.
This is the same as pressing the (Playback) (page 24).

### (Index Display): Playing back a list of images

This is the same as pressing the (Index) (page 25).
Displays a list of images contained in the selected folder.

### (Slide Show): Playing back a series of images

1. Select [Slide Show].
2. Select [Start] with ▲/▼, then press ● to start playback.

**To pause the slide show**

Press ● on the control button.
To restart, select [Continue] with ▲/▼, then press ●.
- The slide show resumes from the image which was paused, however, the music starts again from the beginning.

**To display the previous/next image**

Press ◄/► while the slide show is paused.

**To adjust the volume of the music**

Press ▼ to display the volume control screen, then press ◄/► to adjust the volume.
Playing back images from the HOME screen

To end the slide show
Select [Exit] with ▲▼ while the slide show is paused, then press ●.

To change the setup
The default settings are marked with ✔.

<table>
<thead>
<tr>
<th>Image</th>
<th>Only when a “Memory Stick Duo” (not supplied) is inserted in the camera.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ Folder</td>
<td>Plays back all the images in the selected folder.</td>
</tr>
<tr>
<td>All</td>
<td>Plays back all the images in a “Memory Stick Duo” in order.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Effects</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ Simple</td>
<td>A simple slide show suitable for a wide range of scenes.</td>
</tr>
<tr>
<td>Nostalgic</td>
<td>A moody slide show reproducing the atmosphere of a movie scene.</td>
</tr>
<tr>
<td>Stylish</td>
<td>A stylish slide show proceeding at a middle tempo.</td>
</tr>
<tr>
<td>Active</td>
<td>A high-tempo slide show suitable for active scenes.</td>
</tr>
<tr>
<td>Normal</td>
<td>A basic slide show switching images at a predetermined interval.</td>
</tr>
</tbody>
</table>

- Only still images are displayed when [Simple], [Nostalgic], [Stylish] or [Active] is selected.
- Music is not played (set to [Off]) during a [Normal] slide show. The sound of movies will be heard.

<table>
<thead>
<tr>
<th>Music</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ Music1</td>
<td>The default setting for a [Simple] slide show.</td>
</tr>
<tr>
<td>Music2</td>
<td>The default setting for a [Nostalgic] slide show.</td>
</tr>
<tr>
<td>Music3</td>
<td>The default setting for a [Stylish] slide show.</td>
</tr>
<tr>
<td>Music4</td>
<td>The default setting for a [Active] slide show.</td>
</tr>
<tr>
<td>Off</td>
<td>Setting for a [Normal] slide show. No Music available.</td>
</tr>
</tbody>
</table>
Playing back images from the HOME screen

<table>
<thead>
<tr>
<th>Interval</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>3 sec</td>
<td>Sets the display interval of images for a [Normal] slide show.</td>
</tr>
<tr>
<td>5 sec</td>
<td></td>
</tr>
<tr>
<td>10 sec</td>
<td></td>
</tr>
<tr>
<td>30 sec</td>
<td></td>
</tr>
<tr>
<td>1 min</td>
<td></td>
</tr>
<tr>
<td>✓ Auto</td>
<td>The interval is set to suit the selected [Effects] item. The setting is fixed to [Auto] when [Normal] is not selected as the [Effects].</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Repeat</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ On</td>
</tr>
<tr>
<td>Off</td>
</tr>
</tbody>
</table>

To add /change Music files

You can transfer a desired music file from your CDs or MP3 files to the camera to play back during Slide show. You can transfer music using [Music Tool] in (Printing, Other) on the HOME screen and the “Music Transfer” software (supplied) installed on a computer. For details, see pages 87 and 89.

- You can record up to four pieces of music on the camera (The four preset pieces (Music1-Music4) can be replaced with the ones you transferred).
- A maximum length of each music file for music playback of the camera is 180 seconds.
- If you cannot play back a Music file due to damage or other malfunctions to the file, execute [Format Music] (page 87) and transfer the music again.
Viewing menu

For details on the operation page 30

This section explains the menu items available when you press the MENU button in playback mode. For details on how to use the menu, see page 30.

❖ (Delete): Deleting images

Selects and deletes images on the single-image screen or the index screen. See page 26.

<table>
<thead>
<tr>
<th>(This Image)</th>
<th>Deletes the currently selected image.</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Multiple Images)</td>
<td>Selects and deletes multiple images.</td>
</tr>
<tr>
<td>(All In This Folder)</td>
<td>Deletes all the images in the selected folder.</td>
</tr>
</tbody>
</table>

❖ (Slide Show): Playing back a series of images

This item has same function as ❖ (Slide Show) on the HOME screen. See page 46.

❖ (Retouch): Retouching still images after shooting

Allows you to make adjustments of a still image or apply special effects to a still image. The original image is retained.

❖ (Soft Focus) Blur the periphery around a chosen point

1 Set the center point of the desired image to retouch with ▲/▼/◄/►, then press MENU button.
2 Select [Level] with ▲/▼ and press ●. Select level of retouch with ▲/▼, then press ● again.
3 Adjust the desired range to retouch with W/T button.
4 Select [OK] and press ●.
**Viewing menu**

*For details on the operation page 30*

<table>
<thead>
<tr>
<th><strong>[ ] (Partial Color)</strong></th>
<th>Surround a chosen point in monochrome</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Example Image" /></td>
<td><img src="image2" alt="Example Image" /></td>
</tr>
<tr>
<td>① Set the center point of the desired image to retouch with ▲/▼/ ◄/►, then press MENU button.</td>
<td></td>
</tr>
<tr>
<td>② Adjust the desired range to retouch with W/T button.</td>
<td></td>
</tr>
<tr>
<td>③ Select [OK] and press ●.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>[ ] (Fisheye Lens)</strong></th>
<th>Apply a fisheye effect around a chosen point</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3" alt="Example Image" /></td>
<td><img src="image4" alt="Example Image" /></td>
</tr>
<tr>
<td>① Set the center point of the desired image to retouch with ▲/▼/ ◄/►, then press MENU button.</td>
<td></td>
</tr>
</tbody>
</table>
| ② Select [Level] with ▲/▼ and press ●. 
Select level of retouch with ▲/▼, then press ● again. |
| ③ Select [OK] and press ●. |

<table>
<thead>
<tr>
<th><strong>[ ] (Cross Filter)</strong></th>
<th>Add a starburst effect to bright points in the image</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5" alt="Example Image" /></td>
<td><img src="image6" alt="Example Image" /></td>
</tr>
</tbody>
</table>
| ① Select [Level] with ▲/▼ and press ●. 
Select level of retouch with ▲/▼, then press ● again. |
| ② Adjust the desired length to retouch with W/T button. |
| ③ Select [OK] and press ●. |
Using functions for viewing

### Viewing menu

*For details on the operation page 30*

<table>
<thead>
<tr>
<th>(Trimming)</th>
<th>Crop images to remove unwanted portions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Press W/T button to zoom in on the trimming range.</td>
<td></td>
</tr>
<tr>
<td>Set the point with ▲/▼/◄/►, then press MENU button.</td>
<td></td>
</tr>
<tr>
<td>Select [Image Size] with ▲/▼ and press ●. Select the image size to be used to save the image, then press ●.</td>
<td></td>
</tr>
<tr>
<td>Select [OK] and press ●.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>(Red Eye Correction)</th>
<th>Removes red eye caused by flash</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select [OK] with ▲/▼ and press ●.</td>
<td></td>
</tr>
<tr>
<td>• You may not be able to remove the red eye effect, depending on the image.</td>
<td></td>
</tr>
</tbody>
</table>

When you select [Trimming]

- The image size that you can trim may vary depending on the image.
- The quality of trimmed images may deteriorate.
- Images cannot be retouched while connected to a High Definition TV.
(Protect): Preventing accidental erasure

Protects images against accidental erasure.

<table>
<thead>
<tr>
<th>(Protect)</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>(This Image)</td>
<td>Protects/unlocks the currently selected image.</td>
</tr>
<tr>
<td>(Multiple Images)</td>
<td>Selects and protects/unlocks multiple images.</td>
</tr>
</tbody>
</table>

To protect an image

1. Display the image you want to protect, or select the images on the index screen.
2. Press MENU to display the menu.
3. Select (Protect) with ▲/▼, and select [This Image] with ◀/▶, then press ●.
   The image is protected and the (Protect) indicator appears on the image.

To select and protect images

1. Press MENU to display the menu.
2. Select (Protect) with ▲/▼, and select [Multiple Images] with ◀/▶, then press ●.

In single-image mode:
3. Select the image you want to protect with ◀/▶ on the control button, then press ●.
   A ✔️ is attached to the selected image.
4. Press ◀/▶ to display other images you want to protect, then press ●.
5. Press MENU.

In index mode:
3. Select the image you want to protect with ▲/▼/◀/▶ on the control button, then press ●.
   A ✔️ is attached to the selected image.
4. Move the highlight to the folder selection bar with ◁ and select the folder that contains the images you want to protect with ▲/▼. Repeat step 3 to select other images.
5. To select all the images in the folder, press ● in step 4.
   A ✔️ is attached to the selected folder.
6. Press MENU.
7. Select [OK] with ▲, then press ●.
   A (Protect) indicator appears on the selected images.
To cancel the protection
Select the image for which you want to cancel protection, and unlock it by performing the same procedure to protect it.
The \textcircled{\text{0}} (Protect) indicator disappears.

- Note that the formatting erases all the data stored on the recording media, even if the images are protected, and these images cannot be restored.
- It may take some time to protect an image.

\textbf{DPOF: Adding a Print order mark}

Adds a DPOF (Print order) mark to images you want to print (page 94).

<table>
<thead>
<tr>
<th>DPOF (This Image)</th>
<th>Attaches/clears the DPOF-based print marks to (from) the currently selected image.</th>
</tr>
</thead>
<tbody>
<tr>
<td>DPOF (Multiple Images)</td>
<td>Selects images and attaches/clears the DPOF-based print marks to (from) the images.</td>
</tr>
</tbody>
</table>

\textbf{(Print): Printing images using a printer}

See page 91.
The menu operation is the same procedure as the one used when selecting this item from the HOME screen.

\textbf{(Rotate): Rotating a still image}

Rotates a still image.

1. Display the image to be rotated.
2. Press MENU to display the menu.
3. Select \textbullet (Rotate) with \textgreater/\textless on the control button, then press \textbullet.
4. Select [\textgreater/\textless], then rotate the image with \textgreater/\textless.
5. Select [OK] with \textgreater/\textless, then press \textbullet.

- You cannot rotate protected images or movies.
- You may not be able to rotate images shot with other cameras.
- When viewing images on a computer, the image rotation information may not be reflected depending on the software.
(Select Folder): Selecting the folder for viewing images

Selects the folder containing the image you want to play back when using the camera with “Memory Stick Duo”.

1. Select the desired folder with ◀/▶ on the control button.

2. Select [OK] with ▲, then press ●.

To cancel selecting the folder selection

Select [Exit] in step 2, then press ●.

On the folder

The camera stores images in a specified folder of a “Memory Stick Duo”. You can change the folder or create a new one.

- To create a new folder → [Create REC.Folder] (page 57)
- To change the folder for recording images → [Change REC.Folder] (page 58)
- When multiple folders are created in the “Memory Stick Duo” and the first or last image in the folder is displayed, the following indicators appear.

  : Moves to the previous folder.

  : Moves to the next folder.

  : Moves to either the previous or next folders.
Customizing the Manage Memory feature and the Settings

You can change the default settings using (Manage Memory) or (Settings) on the HOME screen.

1. Press HOME to display the HOME screen.

2. Select (Manage Memory) or (Settings) with on the control button.

3. Select the desired item with , then press .

4. Move the highlight to the item selection area with , and select the desired item with , then press .
5 Select the desired setting with ▲/▼, then press ●.

To cancel the setting change
Select [Cancel] if it is one of the setting item, then press ●. If not, press ◀.
- This setting is maintained even when the power is turned off.
- To switch to the shooting mode, press the shutter button halfway down.
Memory Tool – Memory Stick Tool

This item appears only when a “Memory Stick Duo” is inserted in the camera.

Format

Formats the “Memory Stick Duo”. A commercially available “Memory Stick Duo” is already formatted, and can be used immediately.
- Note that formatting irrevocably erases all data on a “Memory Stick Duo”, including even protected images.

1. Select [Format] with ▲/▼/◄/► on the control button, then press ●.
   The message “All data on Memory Stick will be erased” appears.

2. Select [OK] with ▲, then press ●.
   The format is complete.

To cancel the formatting
Select [Cancel] in step ②, then press ●.

Create REC.Folder

Creates a folder in a “Memory Stick Duo” for recording images.

1. Select [Create REC.Folder] with ▲/▼/◄/► on the control button, then press ●.
   The folder creation screen appears.

2. Select [OK] with ▲, then press ●.
   A new folder is created with a number incremented one higher than the largest number, and the folder becomes the current recording folder.

To cancel the folder creation
Select [Cancel] in step ②, then press ●.

- When not creating a new folder, the “101MSDCF” folder is selected as the recording folder.
- You can create folders designated up to “999MSDCF.”
- Images are recorded in the newly created folder until a different folder is created or selected.
- You cannot delete a folder with the camera. To delete a folder, use your computer, etc.
- Up to 4,000 images can be stored in one folder. When the folder capacity is exceeded, a new folder is automatically created.
- For details, see “Image file storage destinations and file names” (page 79).
Manage Memory

For details on the operation page 55

Change REC.Folder

Changes the folder currently used for recording images.

1. Select [Change REC.Folder] with ▲/▼/◄/► on the control button, then press ●. The folder selection screen appears.

2. Select the desired folder with ◄/►, and [OK] with ▲, then press ●.

To cancel changing the recording folder
Select [Cancel] in step 2, then press ●.

- You cannot select the “100MSDCF” folder as a recording folder.
- You cannot move recorded images to a different folder.

Copy

Copies all images in the internal memory to a “Memory Stick Duo”.

1. Insert a “Memory Stick Duo” having 32 MB or larger capacity.

2. Select [Copy] with ▲/▼/◄/► on the control button, then press ●. The message “All data in internal memory will be copied” appears.


To cancel the copying
Select [Cancel] in step 3, then press ●.

- Use a fully charged battery pack. If you attempt to copy image files using a battery pack with little remaining charge, the battery pack may run out, causing copying to fail or possibly corrupting the data.
- You cannot copy individual images.
- The original images in the internal memory are retained even after copying. To delete the contents of the internal memory, remove the “Memory Stick Duo” after copying, then execute the [Format] command in [Internal Memory Tool] (page 59).
- When you copy the data in the internal memory to the “Memory Stick Duo”, all the data will be copied. You cannot choose a specific folder on the “Memory Stick Duo” as the destination for the data to be copied.
- Even if you copy data, a DPOF (Print order) mark is not copied.
Memory Tool – Internal Memory Tool

This item does not appear when a “Memory Stick Duo” is inserted in the camera.

Format

Formats the internal memory.
- Note that formatting irrevocably erases all data in the internal memory, including even protected images.

1. Select [Format] with ▲/▼/←/→ on the control button, then press ●.
   The message “All data in internal memory will be erased” appears.

2. Select [OK] with ▲, then press ●.
   The format is complete.

To cancel the formatting

Select [Cancel] in step 2, then press ●.
**Main Settings – Main Settings 1**

The default settings are marked with ✔️.

### Beep

Selects the sound produced when you operate the camera.

<table>
<thead>
<tr>
<th>Shutter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ On</td>
<td>Turns on the beep/shutter sound when you press the control button/press the shutter button.</td>
</tr>
<tr>
<td>Off</td>
<td>Turns off the beep/shutter sound.</td>
</tr>
</tbody>
</table>

### Function Guide

When you operate the camera, the description of functions is displayed.

<table>
<thead>
<tr>
<th>Shutter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ On</td>
<td>Displays the function guide.</td>
</tr>
<tr>
<td>Off</td>
<td>Does not display the function guide.</td>
</tr>
</tbody>
</table>

### Initialize

Initializes the setting to the default setting. The images stored in the internal memory are retained.

1. Select [Initialize] with ▲/▼/◄/►, then press ●. The message “Initialize all settings” appears.
2. Select [OK] with ▲, then press ●. The settings are reset to the default setting.

**To cancel the resetting**

Select [Cancel] in step ②, then press ●.

- Make sure that the power is not disconnected during resetting.
Main Settings – Main Settings 2

The default settings are marked with ✓.

**USB Connect**

Selects the USB mode to be used when connecting the camera to a computer or a PictBridge compliant printer using the cable for multi-use terminal.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PictBridge</td>
<td>Connects the camera to a PictBridge compliant printer (page 91). Or, when you connect the camera to a computer, the copy wizard starts automatically, and the images in the recording folder on the camera are copied to the computer (compatible with the computer installed Windows XP, Mac OS X).</td>
</tr>
<tr>
<td>Mass Storage</td>
<td>Establishes a Mass Storage connection between the camera and a computer or other USB device (page 75).</td>
</tr>
<tr>
<td>✓ Auto</td>
<td>The camera recognizes automatically and sets up communication with a computer or PictBridge compliant printer (pages 75 and 91).</td>
</tr>
<tr>
<td></td>
<td>• If the camera and a PictBridge compliant printer cannot be connected when set to [Auto], change the setting to [PictBridge].</td>
</tr>
<tr>
<td></td>
<td>• If the camera and a computer or other USB device cannot be connected when set to [Auto], change the setting to [Mass Storage].</td>
</tr>
</tbody>
</table>

**COMPONENT**

Selects the video signal output type from SD and HD(1080i), according to the TV connected. See page 69.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ HD(1080i)</td>
<td>Selects this item to connect the camera to a 1080i-capable High Definition TV.</td>
</tr>
<tr>
<td>SD</td>
<td>Selects this item to connect the camera to a TV that is not compatible with an HD(1080i) signal.</td>
</tr>
</tbody>
</table>
Video Out

Sets the video signal output according to the TV color system of the connected video equipment. Different countries and regions use different TV color systems. If you want to view images on a TV screen, check page 70 for the TV color system of the country or region where the camera is used.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>Sets the video output signal to NTSC mode (e.g., for the USA, Japan).</td>
</tr>
<tr>
<td>PAL</td>
<td>Sets the video output signal to PAL mode (e.g., for Europe).</td>
</tr>
</tbody>
</table>
### Shooting Settings – Shooting Settings 1

The default settings are marked with ✓.

#### AF Illuminator

The AF illuminator supplies fill light to focus more easily on a subject in dark surroundings. The AF illuminator emits red light allowing the camera to focus easily when the shutter button is pressed halfway, until the focus is locked. The ✓ indicator appears at this time.

| ✓ Auto | Uses the AF illuminator. |
| Off   | Does not use AF illuminator. |

- If the AF illuminator light does not reach the subject sufficiently or the subject has no contrast, focus will not be achieved. (A distance of up to approximately 2.7 m (8 feet 10 3/8 inches) (zoom: W) / 2.5 m (8 feet 2 1/2 inches) (zoom: T) is recommended.)
- Focus is achieved as long as the AF illuminator light reaches the subject, even if the light is slightly off the center of the subject.
- When Focus preset is set (page 42), AF Illuminator does not function.
- When you use AF illuminator, the normal AF range finder frame is disabled and new AF range finder frame is displayed by a dotted line. In this case, AF operates with priority on subjects located near the center of the frame.
- The AF illuminator does not operate when [Twilight], [Landscape], [Hi-Speed Shutter] or [Fireworks] mode is selected in the Scene Selection mode.
- The AF illuminator emits very bright light. Although there are no problems with safety, do not look directly into the AF illuminator emitter at close range.
- When [Face Detection] is set to [On], AF Illuminator does not function.

#### Grid Line

With reference to the grid lines, you can easily set a subject in a horizontal/vertical position.

| On | Displays grid lines. |
| Off | Does not display grid lines. |

- The grid lines are not recorded on the image.
For details on the operation page 55

### AF Mode

Selects the auto focus operation mode.

<table>
<thead>
<tr>
<th>✔️ Single</th>
<th>Automatically adjusts the focus when the shutter button is pressed and held halfway down. This mode is useful for shooting stationary subjects.</th>
</tr>
</thead>
</table>
| Monitor     | Automatically adjusts the focus before the shutter button is pressed and held halfway down. This mode shortens the time needed for focusing.  
  - Battery consumption is faster than in [Single] mode. |

- When [Face Detection] is set to [On], [AF Mode] does not work.

### Digital Zoom

Selects the digital zoom mode. The camera enlarges the image using optical zoom (up to 3×). When the zoom scale exceeds 3×, the camera uses either smart or precision digital zoom.

| ✔️ Smart (Smart Zoom)  (Smart Zoom) | Enlarges the image digitally with almost no distortion. This is not available when the image size is set to [8M] or [3:2].  
  - The maximum zoom scale of Smart zoom is shown in the following table. |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Precision (Precision Zoom) (Precision Zoom)</td>
<td>Enlarges all image sizes up to a maximum of 6×, but the image quality deteriorates.</td>
</tr>
<tr>
<td>Off</td>
<td>Does not use the digital zoom.</td>
</tr>
</tbody>
</table>

**Image size and maximum zoom scale using Smart zoom**

<table>
<thead>
<tr>
<th>Size</th>
<th>Maximum zoom scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>5M</td>
<td>Approx. 3.8×</td>
</tr>
<tr>
<td>3M</td>
<td>Approx. 4.8×</td>
</tr>
<tr>
<td>VGA</td>
<td>Approx. 15×</td>
</tr>
<tr>
<td>16:9</td>
<td>Approx. 5.1×</td>
</tr>
</tbody>
</table>

- When [Face Detection] is set to [On], you cannot use the Digital Zoom.
Shooting Settings – Shooting Settings 2

The default settings are marked with ✔.

**Auto Orientation**

When the camera is rotated to shoot a portrait image, the camera records its position change and displays the image in the portrait position.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>On</td>
</tr>
<tr>
<td></td>
<td>Off</td>
</tr>
</tbody>
</table>

- Depending on the camera angle, the camera may not be able to record the image with the correct orientation.

**Auto Review**

Displays the recorded image on the screen for approximately two seconds immediately after shooting a still image.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>On</td>
</tr>
<tr>
<td></td>
<td>Off</td>
</tr>
</tbody>
</table>

- If you press the shutter button halfway down during this period, the recorded image display disappears and you can immediately shoot the next image.
Clock Settings

Sets the date and time.

1. Press HOME and select [Clock Settings] from (Settings) on the HOME screen.

   ![Clock Settings Screen]

2. Select the date display format with ▲/▼, then press ●.
3. Select each item with ◀/▶ and set the numeric value with ▲/▼, then press ●.
4. Select [OK], then press ●.

To cancel the clock setting
Select [Cancel], then press ●.
Language Setting

Selects the language to be used to display the menu items, warnings, and messages.
You can view images on a TV screen by connecting the camera to a TV. The connection varies according to the type of TV the camera is connected to.

### Connecting your camera to a TV with cable for multi-use terminal

Turn off both your camera and the TV before connecting the camera and the TV.

1. **Connect the camera to the TV.**

   - Place the camera with the screen facing upwards.
   - If your TV has stereo input jacks, connect the audio plug (black) of the cable for multi-use terminal to the left audio jack.

   ![Diagram of camera and TV connections]

2. **Turn on the TV and set the TV/video input switch to “video.”**

   - For details, see the operating instructions supplied with the TV.

3. **Press \( \text{(Playback)} \) to turn on the camera.**

   Images shot with the camera appear on the TV screen.

   Press ✉️∥\( \text{(Playback)} \) on the control button to select the desired image.

   - When using your camera abroad, it may be necessary to switch the video signal output to match that of your TV system (page 62).
Viewing images on a TV

Connecting your camera to an HD TV

You can view images by connecting the camera to an HD (High Definition) TV with the HD Output Adaptor Cable. This cable is supplied only with the DSC-T25. Please purchase the cable separately if you are using the DSC-T20.

Turn off both your camera and the TV before connecting the camera and the TV.

1 Connect the camera to the TV.

- Place the camera with the screen facing upwards.
- The cable for video jacks (Green/Blue/Red) is the same color as the respective jacks.

2 Turn on the TV and set the TV/video input switch to “video.”

- For details, see the operating instructions supplied with the TV.
3 Press ➤ to turn on the camera.

Images shot with the camera appear on the TV screen.

Press ◀/▶ on the control button to select the desired image.

- Set [COMPONENT] to [HD(1080i)] in [Main Settings 2] by selecting (Settings) on the HOME screen (page 61).
- When using your camera abroad, it may be necessary to switch the video signal output to match that of your TV system (page 62).
- Movies cannot be played back during HD (1080i) output.

**On TV color systems**

If you want to view images on a TV screen, you need a TV with a video input jack and the cable for multi-use terminal. The color system of the TV must match that of your digital still camera. Check the following lists for the TV color system of the country or region where the camera is used.

**NTSC system**

Bahama Islands, Bolivia, Canada, Central America, Chile, Colombia, Ecuador, Jamaica, Japan, Korea, Mexico, Peru, Surinam, Taiwan, the Philippines, the U.S.A., Venezuela, etc.

**PAL system**

Australia, Austria, Belgium, China, Czech Republic, Denmark, Finland, Germany, Holland, Hong Kong, Hungary, Italy, Kuwait, Malaysia, New Zealand, Norway, Poland, Portugal, Singapore, Slovak Republic, Spain, Sweden, Switzerland, Thailand, United Kingdom, etc.

**PAL-M system**

Brazil

**PAL-N system**

Argentina, Paraguay, Uruguay

**SECAM system**

Bulgaria, France, Guiana, Iran, Iraq, Monaco, Russia, Ukraine, etc.
For details on using a Macintosh computer, refer to “Using your Macintosh computer” (page 88).
This section describes the English version of screen contents.

Install the software (supplied) first (page 73)

Copying images to your computer (page 74)

- Viewing images on your computer

Enjoying images using the “Picture Motion Browser” and “Music Transfer” (pages 81 and 87)

- Viewing images saved on your computer
- Viewing photos organized by date
- Editing images
- Adding/changing Music using “Music Transfer”
- Show the location of still images shot on the map (requires an internet connection)
- Creates a disc with the images shot (requires CD or DVD disc writing drive)
- Insert the date on the images and saves or prints them
Enjoying your Windows computer

**Recommended computer environment**

The following environment is recommended for a computer connected to the camera.

**Recommended environment for copying images**

**OS (pre-installed):** Microsoft Windows 2000 Professional, Windows XP Home Edition or Windows XP Professional

- Operation is not assured in an environment based on an upgrade of the operating systems described above or in a multi-boot environment.

**USB jack:** Provided as standard

**Recommended environment for using “Picture Motion Browser” and “Music Transfer”**

**OS (pre-installed):** Microsoft Windows 2000 Professional, Windows XP Home Edition or Windows XP Professional

**Sound card:** 16-bit stereo sound card with speakers

**CPU/Memory:** Pentium III 500 MHz or faster, 128 MB of RAM or more

(Recommended: Pentium III 800 MHz or faster and 256 MB of RAM or more)

**Software:** DirectX 9.0c or later

**Hard Disk:** Disk space required for installation—200 MB or more

**Display:** Screen resolution: 1024 × 768 dots or more

- Colors: High Color (16-bit color) or more

- The software is compatible with DirectX technology. Installation of “DirectX” may be required.

**Notes on connecting your camera to a computer**

- Operations are not guaranteed for all the recommended computer environments mentioned above.

- If you connect two or more USB devices to a single computer at the same time, some devices, including your camera, may not operate, depending on the types of USB devices you are using.

- Operations are not guaranteed when using a USB hub.

- Connecting your camera using a USB interface that is compatible with Hi-Speed USB (USB 2.0 compliant) allows advanced transfer (high speed transfer) as this camera is compatible with Hi-Speed USB (USB 2.0 compliant).

- There are three modes for a USB connection when connecting a computer. [Auto] (default setting), [Mass Storage] and [PictBridge] modes. This section describes the [Auto] and [Mass Storage] as examples. For details on [PictBridge], see page 61.

- When your computer resumes from a suspend or sleep mode, communication between your camera and your computer may not recover at the same time.

**Technical Support**

Additional information on this product and answers to frequently asked questions can be found at the Sony Customer Support Website.

http://www.sony.net/
Installing the software (supplied)

You can install the software (supplied) using the following procedure.

- When using Windows 2000, do not connect the camera to the computer before installation.
- In Windows 2000/XP, log on as Administrator.
- When the supplied software is installed, the USB driver is installed automatically.

1 Turn on your computer, and insert the CD-ROM (supplied) into the CD-ROM drive.

The installation menu screen appears.

   • If it does not appear, double-click (My Computer) → (SONYPICTUTIL).

2 Click [Install].

The “Choose Setup Language” screen appears.

3 Select the desired language, then click [Next].

The [Location Settings] screen appears.

4 Select the [Region] and [Country/Area], then click [Next].

When the [Welcome to the Install Shield Wizard for Sony Picture Utility] appears, click [Next].
The “License Agreement” screen appears.

Read the agreement carefully. If you accept the terms of the agreement, click the radio button next to [I accept the terms of the license agreement] and then click [Next].

5 Follow the instructions on the screen to complete the installation.

   • When the restarting confirmation message appears, restart the computer following the instructions on the screen.
   • DirectX may be installed depending on system environment of your computer.

6 Remove the CD-ROM after the installation is complete.

After you install the software, a shortcut icon for the customers registration website is created on the desktop.

Once you register on the website, you can get secure and useful customer support. http://www.sony.net/registration/di
Copying images to your computer

This section describes the process using a Windows computer as an example. You can copy images from the camera to your computer as follows.

For a computer with a Memory Stick slot

Remove the “Memory Stick Duo” from the camera and insert it in the Memory Stick Duo Adaptor. Insert the Memory Stick Duo Adaptor in the computer and copy the images.

- Even when you are using Windows 95/98/98 Second Edition/NT/Me, you can copy images by inserting the “Memory Stick Duo” into the Memory Stick slot on your computer.
- If the “Memory Stick PRO Duo” is not recognized, see page 101.

For a computer without a Memory Stick slot

Follow Stages 1 through 4 on pages 74 to 78 to copy images.

- When you are using Windows 2000, install the software (supplied) before proceeding. With Windows XP, installation is unnecessary.
- The screen displays shown in this section are the examples for copying images from “Memory Stick Duo”.

With Windows 95/98/98 Second Edition/NT/Me:

This camera is not compatible with these version of the Windows operating system. When you use a computer without a Memory Stick slot, use a commercially available Memory Stick Reader/Writer to copy images from a “Memory Stick Duo” to your computer.

To copy images in the internal memory to your computer, copy the images to a “Memory Stick Duo” first, then copy them to your computer.

Stage 1: Preparing the camera and the computer

1 Insert a “Memory Stick Duo” with recorded images into the camera.
   - When copying images in the internal memory, this step is unnecessary.

2 Insert the sufficiently charged battery pack in the camera, or connect the camera to a wall outlet (wall socket) with the AC Adaptor (not supplied) and the USB, A/V, DC IN cable for multi-use terminal (not supplied).
   - When you copy images to your computer using a battery pack with little remaining charge, copying may fail or image data may become corrupted if the battery pack shuts down too soon.

3 Press (Playback), then turn on the computer.
Using your computer

Stage 2: Connecting the camera and your computer

Connect the camera to your computer.

- With Windows XP, the Auto Play wizard appears on the desktop.

“Connecting to Mass Storage...” appears on the screen of the camera.

1. After making a USB connection in Stage 2, click [Copy pictures to a folder on my computer using Microsoft Scanner and Camera Wizard] → [OK] as the wizard screen appears automatically on the desktop.

Stage 3-A: Copying images to a computer

- For Windows 2000, follow the procedure explained in “Stage 3-B: Copying images to a Computer” on page 77.

- For Windows XP, when the wizard screen does not appear automatically, follow the procedure explained in “Stage 3-B: Copying images to a Computer” on page 77.

This section describes an example of copying images to a “My Documents” folder.

When a USB connection is established for the first time, your computer automatically runs a program to recognize the camera. Wait for a while.
Copying images to your computer

1 The “Scanner and Camera Wizard” screen appears.

2 Click [Next].

   The images saved on the “Memory Stick Duo” of the camera appear.
   • If no “Memory Stick Duo” is inserted, images in the internal memory appear.

3 Click the check box of unwanted images to remove the checkmark so they are not copied, then click [Next].

   The “Picture Name and Destination” screen appears.

4 Select a name and destination for the images, then click [Next].

   Image copying starts. When the copying is completed, the “Other Options” screen appears.
   • This section describes an example of copying images to the “My Documents” folder.

5 Click the radio button next to [Nothing. I’m finished working with these pictures] to select it, then click [Next].

   The “Completing the Scanner and Camera Wizard” screen appears.
Copying images to your computer

6 Click [Finish].

The wizard screen closes.

- To continue copying other images, disconnect the cable for multi-use terminal (page 78). Then follow the procedure explained in “Stage 2: Connecting the camera and your computer” on page 75.

Stage 3-B: Copying images to a Computer

- For Windows XP, follow the procedure explained in “Stage 3-A: Copying images to a computer” on page 75.

This section describes an example of copying images to the “My Documents” folder.

1 Double-click [My Computer] → [Removable Disk] → [DCIM].

2 Double-click the folder where the image files you want to copy are stored.

Then, right-click an image file to display the menu and click [Copy].

3 Double-click the [My Documents] folder. Then, right-click on the “My Documents” window to display the menu and click [Paste].

The image files are copied to the “My Documents” folder.

- On the storage destination of the image files, see page 79.

- When an image with the same file name exists in the copy destination folder, the overwrite confirmation message appears. When you overwrite an existing image with a new one, the original file data is deleted. To copy an image file to the computer without overwriting, change the file name to a different name and then copy the image file. However, note that if you change the file name (page 80), you may not be able to play back that image with your camera.
Stage 4: Viewing images on your computer

This section describes the procedure for viewing copied images in the “My Documents” folder.

1. Click [Start] → [My Documents].

The contents of the “My Documents” folder are displayed.

- If you are not using Windows XP, double-click [My Documents] on the desktop.

2. Double-click the desired image file.

The image is displayed.

To delete the USB connection

Perform the procedures listed below beforehand when:
- Disconnecting the cable for multi-use terminal
- Removing a “Memory Stick Duo”
- Inserting a “Memory Stick Duo” into the camera after copying images from the internal memory
- Turning off the camera

1. Double-click on the tasktray.

2. Click (USB Mass Storage Device) → [Stop].

3. Confirm the device on the confirmation window, then click [OK].

4. Click [OK].

   The device is disconnected.

   - Step 4 is unnecessary for Windows XP.
Image file storage destinations and file names

The image files recorded with your camera are grouped as folders on the “Memory Stick Duo”.

Example: viewing folders on Windows XP

A Folder containing image data recorded using a camera not equipped with the folder creating function
B Folder containing image data recorded using this camera
When no new folders are created, there are folders as follows:
– “Memory Stick Duo”; “101MSDCF” only
– Internal memory; “101_SONY” only

• Image files are named as follows. □□□□ stands for any number within the range from 0001 to 9999. The numerical portions of the name of a movie file recorded in movie mode and its corresponding index image file are the same.
  – Still image files: DSC0□□□□.JPG
  – Movie files: MOV0□□□□.MPG
  – Index image files that are recorded when you record movies: MOV0□□□□.THM
• You cannot record any images to the “100MSDCF” folder. The images in these folders are available only for viewing.
• You cannot record/playback any images to the “MISC” folder.

For more information about folders, see pages 54 and 57.
Viewing image files stored on a computer with your camera (using a “Memory Stick Duo”)

This section describes the process using a Windows computer as an example. When an image file copied to a computer no longer remains on a “Memory Stick Duo”, you can view that image again on the camera by copying the image file on the computer to a “Memory Stick Duo”.

- Step 1 is not necessary if the file name set with your camera has not been changed.
- You may be unable to play back some images depending on the image size.
- When an image file has been processed by a computer or when the image file was recorded using a model other than that of your camera, playback on your camera is not guaranteed.
- When there is no folder, create a folder with your camera (page 57) first, and then copy the image file.

1 **Right-click the image file, then click [Rename]. Change the file name to “DSC0□□□□.”**

   Enter a number from 0001 to 9999 for □□□□.

   • If the overwrite confirmation message appears, enter a different number.
   • An extension may be displayed depending on the computer settings. The extension for still images is JPG, and the extension for movies is MPG. Do not change the extension.

2 **Copy the image file to the “Memory Stick Duo” folder in the following order.**

   ① Right-click the image file, then click [Copy].

   ② Double-click [Removable Disk] or [Sony MemoryStick] in [My Computer].

   ③ Right-click the [□□□□MSDCF] folder in the [DCIM] folder, then click [Paste].

   • □□□□ stands for any number within the range from 100 to 999.
Using the “Picture Motion Browser” (supplied)

You can use still images and movies from the camera more than ever by taking advantage of the software. This section summarizes the “Picture Motion Browser” and gives the basic instructions.

“Picture Motion Browser” overview

With the “Picture Motion Browser” you can:

• Import images shot with the camera and display them on the computer.
• Organize images on the computer on a calendar by shooting date to view them.
• Retouch (Red Eye Correction, etc.), print, and send still images as e-mail attachments, change the shooting date.
• Still images can be printed or saved with the date.
• You can create a data disc using a CD burner drive or DVD burner drive.
• For details on the “Picture Motion Browser”, refer to the Help.

To access the Help, click [Start] → [All Programs] (in Windows 2000, [Programs]) → [Sony Picture Utility] → [Help] → [Picture Motion Browser].

Starting and exiting the “Picture Motion Browser”

Starting the “Picture Motion Browser”

Double-click the (Picture Motion Browser) icon on the desktop.
Or, from the Start menu: Click [Start] → [All Programs] (in Windows 2000, [Programs]) → [Sony Picture Utility] → [Picture Motion Browser].

• The confirmation message of the Information tool appears on the screen when starting the “Picture Motion Browser” for the first time. Select [Start]. This function informs you of news, such as software updates. You can change the setting later.

Exiting the “Picture Motion Browser”

Click \(\times\) button in the top right corner of the screen.

Basic instructions

Follow these steps to import and view images from the camera.

Importing images

1 **Make sure “Media Check Tool”* is running.**

Look for a (Media Check Tool) icon in the taskbar.

* “Media Check Tool” is a program that automatically detects and imports images when a “Memory Stick” is inserted or when the camera is connected.

• If there is no icon: Click [Start] → [All Programs] (in Windows 2000, [Programs]) → [Sony Picture Utility] → [Tools] → [Media Check Tool].
2 Connect the camera to your computer with the cable for multi-use terminal.

After the camera is automatically detected, the [Import Images] screen is displayed.

If you use the Memory Stick slot, refer to page 74 first.
In Windows XP, if the Auto Play Wizard appears, close it.

3 Import the images.

To start importing images, click the [Import] button.

By default, images are imported into a folder created in “My Pictures” that is named with the date of importing.

For instructions on changing the “Folder to be imported”, refer to page 85.

Viewing images

1 Checking imported images.

When importing is complete, the “Picture Motion Browser” starts. Thumbnails of the imported images are displayed.

- The “My Pictures” folder is set as the default folder in “Viewed folders”.
- You can double-click a thumbnail to display the image by itself.

2 Viewing images in “Viewed folders” arranged by shooting date on a calendar

① Click the [Calendar] tab.
Years when images were shot are listed.
② Click the year.
Images shot that year are displayed, arranged on the calendar by shooting date.
③ To display images by month, click the desired month.
Thumbnails of images shot that month are displayed.
④ To display images by time, click the desired date.
Thumbnails of images shot that day are displayed, arranged by hour.
Using the “Picture Motion Browser” (supplied)

3 Displaying individual images

On the hour display screen, double-click a thumbnail to display the image by itself in a separate window.

• To list images from a particular year or month, click that period on the left of the screen.

Displaying images in full-screen mode

To display a slide show of current images in full-screen mode, click the button.

• You can edit displayed images by clicking the toolbar button.

• To play or pause the slide show, click the button on the lower left of the screen.
• To stop the slide show, click the button on the lower left of the screen.
Creating a data disc

Images can be saved in CD or DVD as a data disc.
• CD burner drive or DVD burner drive required.
• The following disc can be used for creating a data disc.
  – CD-R/RW (12 cm)
  – DVD±R/RW (12 cm)
  – DVD±R DL (12 cm)

1 Select images to save on the disc.

• To select two or more adjacent images, click the first image, then hold down the “Shift” key and click the next images.
• To select two or more unadjacent images, hold down the “Ctrl” key and click the other images.

2 Click the button on the toolbar.

The [Create Data Disc] display appears.

3 Click [Start].

4 Follow the display instructions to proceed with creating the data disc.

• To add desired images, drag and drop on the [Create Data Disc] display.

Using Map View to display still images on a map

Map View enables you to display the recorded location of a still image with recording position information.
• To use the Map View function, your computer should be connected to the Internet.

1 Select a thumbnail marked with .

2 Click .

The Map View main window appears.

• Maps and satellite images powered by Google Maps mapping service.

• You can later add position information on the still images, using the Map View. For details, see the Help of Map View.

Selecting all images in a folder

Click the [folders] tab, then right-click on the desired folder icon and select [Create Data Disc]. All images in a folder can be selected.
Using the “Picture Motion Browser” (supplied)

Other functions
Preparation images stored on the computer for viewing
To view them, register the folder that contains the images as one of the “Viewed folders”.

1 Click  on the main screen, or choose [Register Folders to View] from the [File] menu.
The settings screen for “Viewed folders” registration is displayed.

2 Specify the folder with images for importing to register the folder as one of the “Viewed folders”.

3 Click [OK].
The image information is registered in the database.

- Images in any subfolders of “Viewed folders” are also registered.

Changing the “Folder to be imported”
To change the “Folder to be imported”, access the “Import Settings” screen.

1 Choose [Import Settings] → [Location for Imported Images] from the [File] menu.
The “Location for Imported Images” screen is displayed.

2 Choose the “Folder to be imported”.
- You can specify the “Folder to be imported” from folders registered as “Viewed folders.”

Updating image registration information
To update image information, choose [Update Database] from the [Tools] menu.
- Updating the database may take a while.
- If you rename image files or folders in “Viewed folders”, they cannot be displayed with this software. In this case, update the database.

Saving images with the date
① Double-click an image to display it.
② Click  and select [Insert Date] from the drop-down list.
③ Select your desired color and position, and then click [OK].
④ Click  to save.

Printing images with the date
① Select the still image you want to print.
② Click  on the toolbar.
③ Click the check box of [Print date taken] in Print Options.
④ Click [Print].
To uninstall the “Picture Motion Browser”

① Click [Start] → [Control Panel] (in Windows 2000, [Start] → [Settings] → [Control Panel]), then double-click [Add/Remove Programs].

② Select [Sony Picture Utility], then click [Remove] (in Windows 2000, [Change/Remove]) to execute the uninstallation.
Using the “Music Transfer” (supplied)

You can change the Music files that are preset at the factory with desired Music files using “Music Transfer” in the CD-ROM (supplied). Also, you can delete or add these files whenever you want.

Adding/Changing Music using “Music Transfer”

The music formats you can transfer with “Music Transfer” are listed below:
- MP3 files stored on the hard drive of your computer
- Music on CDs
- Preset-music saved on this camera

1 Press HOME to display the HOME screen.

2 Select  (Printing, Other) with ◀/▶ on the control button, then select [ Music Tool] with ▲/▼, then press ●.

3 Select [Download Music] with ▲/▼/◀/▶, then press ●.

   The message “Connect to PC” appears.

4 Make a USB connection between the camera and your computer.

5 Start “Music Transfer.”

6 Follow the instructions on the screen to add/change Music files.

- To restore the music preset at the factory to the camera:
  2. Execute [Restore defaults] on “Music Transfer.” All Music files return to the preset-music, and [Music] in the [Slide Show] menu is set to [Off].
  3. Select a suitable Music file for the slide show effect (page 46). You can reset the Music files to the preset ones using [Initialize] (page 60), however, other settings will also be reset.

- For details on using “Music Transfer,” see the on-line help in “Music Transfer.”
Using your Macintosh computer

You can copy images to your Macintosh computer.

- “Picture Motion Browser” is not compatible with Macintosh computers.

**Recommended computer environment**

The following environment is recommended for a computer connected to the camera.

**Recommended environment for copying images**

**OS (pre-installed):** Mac OS 9.1/9.2/ Mac OS X (v10.1 to v10.4)

**USB jack:** Provided as standard

**Recommended environment for using “Music Transfer”**

**OS (pre-installed):** Mac OS X (v10.3 to v10.4)

**CPU:** iMac, eMac, iBook, PowerBook, Power Mac G3/G4/G5 series, Mac mini

**Memory:** 64 MB or more (128 MB or more is recommended)

**Hard Disk:** Disk space required for installation—approximately 250 MB

**Notes on connecting your camera to a computer**

- Operations are not guaranteed for all the recommended computer environments mentioned above.
- If you connect two or more USB devices to a single computer at the same time, some devices, including your camera, may not operate depending on the types of USB devices you are using.
- Operations are not guaranteed when using a USB hub.
- Connecting your camera using a USB interface that is compatible with Hi-Speed USB (USB 2.0 compliant) allows advanced transfer (high speed transfer) as this camera is compatible with Hi-Speed USB (USB 2.0 compliant).
- There are three modes for a USB connection when connecting a computer, [Auto] (default setting), [Mass Storage] and [PictBridge] modes. This section describes the [Auto] and [Mass Storage] as examples. For details on [PictBridge], see page 61.
- When your computer resumes from the suspend or sleep mode, communication between your camera and your computer may not recover at the same time.

**Copying and viewing images on a computer**

1. **Prepare the camera and a Macintosh computer.**
   
   Perform the same procedure as described in “Stage 1: Preparing the camera and the computer” on page 74.

2. **Connect the cable for multi-use terminal.**
   
   Perform the same procedure as described in “Stage 2: Connecting the camera and your computer” on page 75.

3. **Copy image files to the Macintosh computer.**

   ① Double-click the newly recognized icon → [DCIM] → the folder where the images you want to copy are stored.
   
   ② Drag and drop the image files to the hard disk icon.
   
   The image files are copied to the hard disk.
   
   • For details on the storage location of the images and file names, see page 79.
Using your Macintosh computer

4 View images on the computer.

Double-click the hard disk icon → the desired image file in the folder containing the copied files to open that image file.

To delete the USB connection

Perform the procedures listed below beforehand when:
- Disconnecting the cable for multi-use terminal
- Removing a “Memory Stick Duo”
- Inserting a “Memory Stick Duo” into the camera after copying images from the internal memory
- Turning off the camera

Drag and drop the drive icon or the icon of the “Memory Stick Duo” to the “Trash” icon.

The camera is disconnected from the computer.

Adding/Changing Music using “Music Transfer”

You can change the Music files that are preset at the factory with desired Music files. Also, you can delete or add these files whenever you want.

The music formats you can transfer with “Music Transfer” are listed below:
- MP3 files stored on the hard drive of your computer
- Music on CDs
- Preset-music saved on this camera

To install “Music Transfer”

- Shut down all other application software before you install “Music Transfer.”
- For installation, you need to log on as Administrator.

Technical Support

Additional information on this product and answers to frequently asked questions can be found at the Sony Customer Support Website.
http://www.sony.net/
Printing still images

How to print still images

When you print images shot in [16:9] mode, both edges may be cut off, so be sure to check before printing (page 104).

Printing directly using a PictBridge compliant printer (page 91)

You can print images by connecting the camera directly to a PictBridge compliant printer.

Printing directly using a “Memory Stick” compliant printer

You can print images with a “Memory Stick” compliant printer. For details, see the operating instructions supplied with the printer.

Printing using a computer

You can copy images to a computer using the supplied “Picture Motion Browser” software and print the images. You can insert the date on the image and print it (page 85).

Printing at a shop (page 94)

You can take a “Memory Stick Duo” containing images shot with your camera to a photo printing service shop. You can make a DPOF (Print order) mark on images which you want to print out in advance.
Printing images directly using a PictBridge compliant printer

Even if you do not have a computer, you can print images shot using your camera by connecting the camera directly to a PictBridge compliant printer.

PictBridge

- “PictBridge” is based on the CIPA standard. (CIPA: Camera & Imaging Products Association)
- You cannot print movies.
- If the indicator flashes on the screen of the camera (error notification), check the connected printer.

Stage 1: Preparing the camera

Prepare the camera to connect it to the printer with the cable for multi-use terminal. When connecting the camera to a printer that is recognized when [USB Connect] is set to [Auto], Stage 1 is unnecessary.

1. Press HOME to display the HOME screen.

2. Select (Settings) with , then select [Main Settings] with , and then press .

3. Select [Main Settings 2] with , and select [USB Connect], then press .

4. Select [PictBridge] with , then press . The USB mode is set.

- It is recommended to use a fully charged battery pack to prevent the power from turning off partway through printing.
Stage 2: Connecting the camera to the printer

1 Connect the camera to the printer.

2 Turn on your camera and the printer.

After the connection is made, the indicator appears.

Stage 3: Selecting an image to print

Select [This Image] or [Multiple Images] with ▲/▼, then press ●.

When you select [This Image]
Prints the currently selected image. Jump to step 4.

When you select [Multiple Images]
Selects and prints multiple images.

1 Select the image you want to print with ▲/▼/◄/►, then press ●. A ✔ mark appears on the selected image.

2 Press MENU to display the menu.

3 Select [OK] with ▲, then press ●.

- When the index screen is displayed, you can print all the images in the folder by selecting [Multiple Images] and moving the highlight to the folder bar with ◄, then putting a checkmark in the checkbox of the folder.

The camera is set to playback mode, then an image and the print menu appear on the screen.
Stage 4: Printing

1 Select print settings with ▲/▼/◄/►.

[Quantity]
When the [Layout] is set to [1-up/Borderless] or [1-up/Border]:
Select the number of sheets of an image that you want to print. The image will be printed as a single image.

When the [Layout] is not set to [1-up/Borderless] or [1-up/Border]:
Select the number of sets of images that you want to print as an index image. If you selected [This Image] in step 1, select the number of the same image you want to print side by side on a sheet as an index image.
• The designated number of images may not all fit onto a single sheet depending on the quantity of images.

[Layout]
Specify the number of images to be printed on a sheet of paper.

[Size]
Select the size of the printing sheet.

[Date]
Select [Day&Time] or [Date] to insert the date and time on images.
• When you choose [Date], the date will be inserted in the order you select (page 66). This function may not be provided depending on the printer.

2 Select [OK] with ▲, then press ◎.
The image is printed.
• Do not disconnect the cable for multi-use terminal while the (PictBridge Connecting) indicator appears on the screen.

To print other images
Select [Multiple Images], then perform the process again from stage 3.

Stage 5: Stopping the print job
Disconnect the cable for multi-use terminal from the camera after the screen changes to the same one that appears in stage 2.
You can take a “Memory Stick Duo” containing images shot with your camera to a photo printing service shop. As long as the shop supports photo printing services conforming to the DPOF, you can make a DPOF (Print order) mark on images in advance so that you do not need to reselect them when you print them out at the shop.

- You cannot print images stored in the internal memory at a print shop directly from the camera. Copy the images to a “Memory Stick Duo”, then take the “Memory Stick Duo” to the print shop.

What is DPOF?

DPOF (Digital Print Order Format) is a function allowing you to make a DPOF (Print order) mark on images of “Memory Stick Duo” that you want to print out later.

- You can also print the images with the DPOF (Print order) mark using a printer that conforms to the DPOF (Digital Print Order Format) standard or using a PictBridge compliant printer.
- You cannot mark movies.

When taking a “Memory Stick Duo” to a shop

- Consult your photo printing service shop as to what types of “Memory Stick Duo” they handle.
- If a “Memory Stick Duo” is not handled by your photo printing service shop, copy the images you want to print out to other medium such as a CD-R and take it to the shop.
- Be sure to take the Memory Stick Duo Adaptor with it.
- Before you take image data to a shop, always copy (back up) your data to a disk.
- You cannot set the number of prints.
- When you want to superimpose dates on images, consult your photo printing service shop.

Marking a selected image

1. Display the image you want to print.

2. Press MENU to display the menu.

3. Select [DPOF] with ▲/▼ and select [This Image], then press ●.

A DPOF (Print order) mark is attached to the image.

To remove the mark

Select the images from which you want to remove the mark, then press ● in step 3.
Printing at a shop

Selecting and marking the images

1 Press MENU to display the menu.

2 Select [DPOF] with ▲/▼ and select [Multiple Images], then press ●.

3 Select the image you want to mark with ▲/▼/◄/►, then press ●.
   A √ mark is attached to the selected image.

To cancel the selection
To cancel, select [Exit] in step 5, then press ●.

To remove the mark
Select the images from you want to remove the marks, then press ● in step 3.

To mark all the images in the folder
In step3, move the frame to the folder bar with ◄, then press the ●.
A √ mark is attached to the selected folder and all the images.

4 Press MENU.

5 Select [OK] with ▲, then press ●.
If you experience trouble with your camera, try the following solutions.

1. **Check the items on pages 97 to 106.**
   If a code such as “C/E:□□:□□” appears on the screen, see page 107.

2. **Remove the battery pack, and insert the battery pack again after about one minute, and turn on the power.**

3. **Initialize the settings (page 60).**

4. **Consult your Sony dealer or local authorized Sony service facility.**

Please understand that you give your consent that the contents of the internal memory, Music files may be checked when you send your camera to be repaired.

Click one of the following items to jump to the page explaining the symptom and cause or the appropriate corrective action.

<table>
<thead>
<tr>
<th>Battery pack and power</th>
<th>97</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Memory Stick Duo”</td>
<td>103</td>
</tr>
<tr>
<td>Shooting still images/movies</td>
<td>97</td>
</tr>
<tr>
<td>Internal memory</td>
<td>104</td>
</tr>
<tr>
<td>Viewing images</td>
<td>100</td>
</tr>
<tr>
<td>Printing</td>
<td>104</td>
</tr>
<tr>
<td>Deleting/Editing images</td>
<td>101</td>
</tr>
<tr>
<td>PictBridge compliant printer</td>
<td>105</td>
</tr>
<tr>
<td>Computers</td>
<td>101</td>
</tr>
<tr>
<td>Others</td>
<td>106</td>
</tr>
<tr>
<td>Picture Motion Browser</td>
<td>103</td>
</tr>
</tbody>
</table>
**Troubleshooting**

**Battery pack and power**

**The battery pack cannot be installed.**
- Install the battery pack correctly using the tip of the battery pack to push the battery eject lever toward the bottom of the camera.

**Cannot turn on the camera.**
- After installing the battery pack into the camera, it may take a little while to get the camera powered.
- Install the battery pack correctly.
- The battery pack is discharged. Install charged battery pack.
- The battery pack is dead (page 113). Replace it with a new one.
- Use a recommended battery pack.

**The power turns off suddenly.**
- If you do not operate the camera for about three minutes while the power is on, the camera turns off automatically to prevent wearing down the battery pack. Turn on the camera again.
- The battery pack is dead (page 113). Replace it with a new one.

**The battery remaining indicator is incorrect.**
- This phenomenon occurs when you use the camera in an extremely hot or cold location.
- The displayed battery remaining differs from the current one. Fully discharge and then charge the battery pack to correct the display.
- The battery pack is discharged. Install the charged battery pack.
- The battery pack is dead (page 113). Replace it with a new one.

**Cannot charge the battery pack**
- You cannot charge the battery pack using the AC Adapter (not supplied).

**Shooting still images/movies**

**Your camera cannot record images.**
- Check the free capacity of the internal memory or “Memory Stick Duo”. If it is full, do one of the following:
  - Delete unnecessary images (page 26).
  - Change the “Memory Stick Duo”.
- You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 111).
- You cannot record images while charging the flash.
- Select a shooting mode other than [Movie Mode] using the HOME screen when shooting still images.
- Select [Movie Mode] using the HOME screen when shooting movies.
Troubleshooting

• The image size is set to [640(Fine)] when recording movies. Do one of the following:
  – Set the image size to other than [640(Fine)].
  – Insert a “Memory Stick PRO Duo”.

Movie recording stops during shooting

• Movie recording stops automatically when the file size of the movie reaches approx. 2 GB.

The subject is not visible on the screen

• Your camera is set to the playback mode. Press  (Playback) to change to the recording mode.

Anti-blur function does not work.

• The anti-blur function does not work when  appears on the display.
• The anti-blur function may not work properly when shooting night scenes.
• Shoot after pressing the shutter button halfway down; do not press it fully down suddenly.

Recording takes a long time.

• The NR slow shutter function is activated (page 15). This is not a malfunction.

The image is out of focus.

• The subject is too close. Shoot in  (Macro) recording mode. Make sure to position the lens farther away from the subject than the shortest shooting distance, approximately 8 cm (3 1/4 inches) (W)/25 cm (9 7/8 inches) (T), when shooting. Or, set  (Close Focus) and focus from a distance of approx. 1 cm to 20 cm (13/32 inch to 7 7/8 inches) from the subject (page 22).
•  (Close Focus) is set, or [Twilight], [Landscape] or [Fireworks] mode is selected in the Scene Selection mode when shooting still images.
• The Focus preset function is selected. Select the auto focus mode (page 42).
• Refer to “If the subject is out of focus” on page 42.

Zoom does not work.

• When  (Close Focus) is selected, the optical zoom is not available.
• The smart zoom cannot be used when the image size is set to [8M] or [3:2].
• The digital zoom cannot be used while shooting movies.
• When [Face Detection] is set to [On], you cannot use the Digital Zoom.

The flash does not work.

• The flash is set to  (Flash forced off) (page 21).
• You cannot use the flash when:
  – [REC Mode] is set to [Burst] or Exposure Bracket (page 37).
  – [High Sensitivity], [Twilight] or [Fireworks] mode is selected in the Scene Selection mode (page 34).
  – Shooting movies.
• Set the flash to $\$\$ \$ (Flash forced on) when \$\$ (Close Focus) is set, or [Landscape], [Hi-Speed Shutter], [Beach], or [Snow] mode is selected in the Scene Selection mode (page 21).

**Fuzzy specks appear in images shot using the flash.**
• Dust in the air reflected the flash light and appeared in the image. This is not a malfunction.

**The close-up shoot function (Macro/Close Focus) does not work.**
• [Twilight], [Landscape] or [Fireworks] mode is selected in the Scene Selection mode (page 34).

**The date and time are not displayed on LCD screen.**
• While shooting, the date and time are not displayed. They are displayed only during playback.

**Cannot insert dates on image**
• This camera does not have a feature for superimposing dates on images (page 104).
• You can insert the date on images and save or print them using “Picture Motion Browser” (page 85).

**The F value and shutter speed flash when you press and hold the shutter button halfway down.**
• The exposure is incorrect. Correct the exposure (page 39).

**The screen is too dark or too bright.**
• Adjust the brightness of the LCD backlight (page 18).

**The image is too dark.**
• You are shooting a subject with a light source behind the subject. Select the metering mode (page 40) or adjust the exposure (page 39).

**The image is too bright.**
• Adjust the exposure (page 39).

**The image colors are not correct.**
• Set [Color Mode] to [Normal] (page 38).

**Vertical streaks appear when you are shooting a very bright subject.**
• The smear phenomenon is occurring and white, black, red, or purple streaks appear on the image.
  This phenomenon is not a malfunction.
## Troubleshooting

**Noise appears in the image when you view the screen in a dark place.**

- The camera is attempting to increase the visibility of the screen by temporarily brightening the image under conditions of low illumination. There is no effect on the recorded image.

**The eyes of the subject come out red.**

- Set [Red Eye Reduction] in the shooting menu to [On] (page 45).
- Shoot the subject at a distance closer than the flash range using the flash.
- Light the room and shoot the subject.
- Retouch the image using [Red Eye Correction] (page 51).

**Dots appear and remain on the screen.**

- This is not a malfunction. These dots are not recorded (page 2).

**Cannot shoot images in succession.**

- The internal memory or “Memory Stick Duo” is full. Delete unnecessary images (page 26).
- The battery level is low. Install charged battery pack.
- You cannot shoot images in succession in Close Focus mode.

### Viewing images

**Your camera cannot play back images.**

- Press  (Playback) (page 24).
- The folder/file name has been changed on your computer (page 80).
- When an image file has been processed by a computer or when the image file was recorded using a model other than that of your camera, playback on your camera is not guaranteed.
- The camera is in USB mode. Delete the USB connection (page 78).

**The date and time are not displayed.**

-  (DISP) button is turned off (page 18).

**The image appears rough right after playback starts.**

- The image may appear rough right after playback starts due to image processing. This is not a malfunction.
Troubleshooting

The image does not appear on the TV screen.

- Check [Video Out] to see if the video output signal of your camera is set to the color system of your TV (page 62).
- Check whether the connection is correct (page 68).
- If the USB connector of the cable for multi-use terminal is connected to another device, disconnect it.

Deleting/Editing images

Your camera cannot delete an image.

- Cancel the protection (page 53).
- You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 111).

You have deleted an image by mistake.

- Once you have deleted an image, you cannot restore it. We recommend that you protect images (page 52), or use the “Memory Stick Duo” with the write-protect switch and set the switch to the LOCK position (page 111) to prevent accidental erasure.

Computers

You do not know if the OS of your computer is compatible with the camera.

- Check “Recommended computer environment” on page 72 for Windows, and page 88 for Macintosh.

“Memory Stick PRO Duo” is not recognized by a computer with a “Memory Stick” slot.

- Check that the computer and the Memory Stick Reader/Writer support “Memory Stick PRO Duo”. Users of computers and Memory Stick Readers/ Writers made by manufacturers other than Sony should contact those manufacturers.
- If “Memory Stick PRO Duo” is not supported, connect the camera to the computer (pages 75 and 88). The computer recognizes the “Memory Stick PRO Duo”.

Your computer does not recognize your camera.

- Turn on the camera.
- When the battery level is low, install the charged battery pack, or use the AC Adaptor (not supplied) (page 74).
- Use the cable for multi-use terminal (supplied) (page 75).
- Disconnect the cable for multi-use terminal from both the computer and the camera, and connect it again firmly.
- Disconnect all equipment other than the camera, the keyboard and the mouse from the USB connectors of your computer.
Troubleshooting

- Connect the camera directly to your computer without passing through a USB hub or other device (page 75).
- The software (supplied) is not installed. Install the software (page 73).
- Your computer does not properly recognize the device because you connected the camera and your computer with the cable for multi-use terminal before you install the software (supplied). Delete the erroneously recognized device from your computer, then install the USB driver (see the next item).

The “Removable disk” icon does not appear on the computer screen when you connect your computer to the camera.

- Follow the procedure below to install the USB driver again. The following procedure is for a Windows computer.
  1. Right-click [My Computer] to display the menu, then click [Properties]. The “System Properties” screen appears.
  2. Click [Hardware] → [Device Manager]. The “Device Manager” appears.
  3. Right-click [Sony DSC], then click [Uninstall] → [OK]. The device is deleted.
  4. Install the software (page 73). A USB driver is also installed.

You cannot copy images.

- Connect the camera and your computer correctly making a USB connection (page 75).
- Follow the designated copy procedure for your OS (pages 75 and 88).
- When you shoot images with a “Memory Stick Duo” formatted by a computer, you may not be able to copy the images to a computer. Shoot using a “Memory Stick Duo” formatted by your camera (page 57).

After making a USB connection, “Picture Motion Browser” does not start automatically.

- Start “Media Check Tool” (page 81).
- Make the USB connection after the computer is turned on (page 75).

The image cannot be played back on a computer.

- If you are using “Picture Motion Browser,” refer to the Help.
- Consult the computer or software manufacturer.

The image and sound are interrupted by noise when you view a movie on a computer.

- You are playing back the movie directly from the internal memory or the “Memory Stick Duo”. Copy the movie to the hard disk of your computer, then play back the movie from the hard disk (page 74).
Troubleshooting

You cannot print an image.
- Refer to the operation manual of the printer.

Images once copied to a computer cannot be viewed on the camera.
- Copy them to a folder recognized by the camera, such as “101MSDCF” (page 79).
- Operate correctly (page 80).

Picture Motion Browser

Images are not displayed correctly with “Picture Motion Browser”.
- Make sure the folder of the images is registered in “Viewed folders”. If the images are not displayed even if the folder is registered in “Viewed folders”, update the database (page 85).

You cannot find images imported with “Picture Motion Browser”.
- Look in the “My Pictures” folder.
- If you have changed the default settings, refer to “Changing the “Folder to be imported”” on page 85 and check what folder is used for importing.

You want to change the “Folder to be imported”.
- Access the “Import Settings” screen to change “Folder to be imported”. You can specify a different folder after using “Picture Motion Browser” to register it in “Viewed folders” (page 85).

The date of all imported images is displayed differently from the date on the calendar.
- The date on the camera is not set correctly. Set the date and time correctly (page 66).

’m is displayed.
- You have renamed or deleted image files or folders, making the image registration information obsolete. Update image registration information by choosing [Update Database] from the [Tools] menu.

“Memory Stick Duo”

Cannot insert a “Memory Stick Duo”.
- Insert it in the correct direction.

Cannot format a “Memory Stick Duo”.
- You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 111).
You have formatted a “Memory Stick Duo” by mistake.

- All the data on the “Memory Stick Duo” is deleted by formatting. You cannot restore it. We recommend that you set the write-protect switch on the “Memory Stick Duo” to the LOCK position to prevent accidental erasure (page 111).

Internal memory

Cannot play back or record images using the internal memory.

- There is a “Memory Stick Duo” inserted in the camera. Remove it.

Cannot copy the data stored in the internal memory to a “Memory Stick Duo”.

- The “Memory Stick Duo” is full. Check the capacity (32 MB or more recommended).

Cannot copy the data on the “Memory Stick Duo” or the computer to the internal memory.

- Data on a “Memory Stick Duo” or a computer cannot be copied to the internal memory.

Printing

Also see “PictBridge compliant printer” (as follows) in conjunction with the following items.

Images are printed with both edges cut off.

- Depending on your printer, the left, right, top, and bottom edges of the image may be cut off. Especially when you print an image shot with the image size set to [16:9], the edge of the image may be cut off.
- When printing images using your own printer, try canceling the trimming or borderless settings. Consult the printer manufacturer as to whether the printer provides these functions or not.
- When having images printed at a digital print shop, ask the shop whether they can print the images without cutting off both edges.

Cannot print images with the date.

- Using “Picture Motion Browser”, you can print images with date (page 85).
- This camera does not have a feature for superimposing dates on images. However, because the images shot with the camera include information on the recording date, you can print images with the date superimposed if the printer or the software can recognize Exif information. For compatibility with Exif information, consult the manufacturer of the printer or the software.
- When you print images at a shop, images can be printed with the date if you ask them to do so.
Troubleshooting

PictBridge compliant printer

A connection cannot be established.

- The camera cannot be connected directly to a printer that is not compliant with the PictBridge standard. Consult the printer manufacturer as to whether the printer is compliant with PictBridge or not.
- Check that the printer is turned on and can be connected to the camera.
- Disconnect and connect the cable for multi-use terminal again. If an error message is indicated on the printer, refer to the operating instructions supplied with the printer.

Cannot print images.

- Check that the camera and the printer are properly connected using the cable for multi-use terminal.
- Turn on the printer. For further information, refer to the operating instructions supplied with the printer.
- If you select [Exit] during printing, images may not be printed. Disconnect and connect the cable for multi-use terminal again. If you still cannot print your images, disconnect the cable for multi-use terminal, turn the printer off and then on, then connect the cable for multi-use terminal again.
- Movies cannot be printed.
- Images shot using cameras other than this camera or images modified with a computer may not be printed.

Printing is canceled.

- Confirm that you have disconnected the cable for multi-use terminal before the (PictBridge Connecting) mark disappears.

Cannot insert the date or print images in the index mode.

- The printer does not provide these functions. Consult the printer manufacturer as to whether the printer provides these functions or not.
- The date may not be inserted in the index mode depending on the printer. Consult the printer manufacturer.

“---- -- --” is printed on the date-inserted part of the image.

- Images that do not have the recording data cannot be printed with the date. Set [Date] to [Off] and print the image again (page 93).

Cannot select the print size.

- Consult the printer manufacturer as to whether the printer can provide the desired size.
Troubleshooting

Cannot print the image at the size selected.
- Disconnect the cable for multi-use terminal and reconnect it whenever you change the paper size after the printer has been connected to the camera.
- The print setting of the camera differs from that of the printer. Change the setting of either the camera (page 93) or the printer.

Cannot operate the camera after canceling printing.
- Wait for a while as the printer is carrying out the cancellation. It may take some time depending on the printer.

Others

The lens gets fogged.
- Moisture condensation has occurred. Turn off the camera and leave it for about an hour before using it.

The camera becomes warm when you use it for a long time.
- This is not a malfunction.

The Clock Set screen appears when you turn on the camera.
- Set the date and time again (page 66).

You want to change the date or time.
- Set the date and time again (page 66).
Warning indicators and messages

Self-diagnosis display

If a code starting with a letter of the alphabet appears, your camera has a self-diagnosis display. The last two digits (indicated by □□) will differ depending on the state of the camera.

If you are unable to solve the problem even after trying the following corrective actions a few times, your camera may need repair. Contact your Sony dealer or local authorized Sony service facility.

C:32:□□
- There is trouble with your camera’s hardware. Turn the power off and on again.

C:13:□□
- The camera cannot read or write data on the “Memory Stick Duo”. Try turning off and on the camera again, or taking out and inserting the “Memory Stick Duo” several times.
- The internal memory has experienced a format error, or an unformatted “Memory Stick Duo” is inserted. Format the internal memory or the “Memory Stick Duo” (pages 59, 57).
- The inserted “Memory Stick Duo” cannot be used with your camera, or the data is damaged. Insert a new “Memory Stick Duo”.

E:61:□□

E:62:□□

E:91:□□
- A camera malfunction has occurred. Initialize the camera (page 60), then turn the power on again.

Messages

If the following messages appear, follow the instructions.

• The battery level is low. Charge the battery pack immediately. Depending on the conditions of use or the type of battery pack, the indicator may flash even though there are still 5 to 10 minutes of remaining battery time left.

For use with compatible battery only
- The battery inserted is not an NP-BG1 (supplied) battery pack.

System error
- Turn the power off and then on again.

Internal memory error
- Turn the power off and then on again.

Reinsert the Memory Stick
- Insert the “Memory Stick Duo” correctly.
- The inserted “Memory Stick Duo” cannot be used in your camera (page 111).
- The “Memory Stick Duo” is damaged.
- The terminal section of the “Memory Stick Duo” is dirty.

Memory Stick type error
- The inserted “Memory Stick Duo” cannot be used in your camera (page 111).

Cannot access Memory Stick Access denied
- You are using a “Memory Stick Duo” with access control.
Warning indicators and messages

**Memory Stick formatting error**
- Internal memory formatting error
  - Format the media again (pages 59 and 57).

**Memory Stick locked**
- You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 111).

**No memory space in internal memory**
**No memory space on Memory Stick**
- Delete unnecessary images or files (page 26).

**Read only memory**
- Your camera cannot record or delete images on this “Memory Stick Duo”.

**No images**
- No images have been recorded on the internal memory in the camera.
- No images have been recorded in the folder.
- The selected folder does not contain a file that can be played in a Slide Show with music.

**Folder error**
- A folder with the same first three digit number already exists on the “Memory Stick Duo” (for example: 123MSDCF and 123ABCDE). Select another folders, or create a new folder (pages 57, 58).

**Cannot create more folders**
- The folder with a name beginning with “999” exists on the “Memory Stick Duo”. You cannot create any folders if this is the case.

**File error**
- An error occurred while the image was playing back.

**Read only folder**
- You have selected a folder that cannot be registered in “Viewed folders”. Select other folders.

**File protect**
- Release the protection (page 53).

**Image size over**
- You are playing back an image of a size that cannot be played back on your camera.

**Invalid operation**
- You are trying to play back a file that is not compatible with the camera.
- You have selected a function that is not available for movies.

**(Vibration warning indicator)**
- Camera shake may occur due to insufficient light. Use the flash, turn on the anti-blur function, or mount the camera on a tripod to secure the camera.

**640(Fine) is not available**
- 640(Fine) size movies can be recorded only using a “Memory Stick PRO Duo”. Insert a “Memory Stick PRO Duo” or set the image size to a size other than [640(Fine)].
Warning indicators and messages

Macro is invalid
- You have selected a setting that is not available for shooting in Macro mode (page 22, 34).

Flash settings cannot be changed
- You have selected a setting that is not available for shooting with the flash (page 34).

Zoom disabled
- [Digital Zoom] is set to [Off] when you are shooting in the Close Focus mode. Or, you are trying to use [Smart] in [Digital Zoom] when the image size is set to [8M] or [3:2] (page 64).

Maximum images selected
- You can select up to 100 images. Remove the checkmark.

No enough battery
- Make sure there is sufficient battery power remaining when you copy the images on the internal memory in the camera to a “Memory Stick Duo”.

Printer busy
Paper error
No Paper
Ink error
Low Ink
No Ink
- Check the printer.

Printer error
- Check the printer.
- Check if the image you want to print is corrupted.
To use your camera abroad — Power sources

You can use your camera, the battery charger (supplied), and the AC-LS5K AC Adaptor (not supplied) in any country or region where the power supply is within 100 V to 240 V AC, 50/60 Hz.

- Do not use an electronic transformer (travel converter), as this may cause a malfunction.
On the “Memory Stick”

A “Memory Stick” is a compact, portable IC recording medium. The types of “Memory Stick” that can be used with this camera are listed in the table below. However, proper operation cannot be guaranteed for all “Memory Stick” functions.

<table>
<thead>
<tr>
<th>“Memory Stick” type</th>
<th>Recording/Playback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Stick (without MagicGate)</td>
<td>—</td>
</tr>
<tr>
<td>Memory Stick (with MagicGate)</td>
<td>—</td>
</tr>
<tr>
<td>Memory Stick Duo (without MagicGate)</td>
<td>○</td>
</tr>
<tr>
<td>Memory Stick Duo (with MagicGate)</td>
<td>○<em>1</em>2</td>
</tr>
<tr>
<td>MagicGate Memory Stick</td>
<td>—</td>
</tr>
<tr>
<td>MagicGate Memory Stick Duo</td>
<td>○*1</td>
</tr>
<tr>
<td>Memory Stick PRO</td>
<td>—</td>
</tr>
<tr>
<td>Memory Stick PRO Duo</td>
<td>○<em>1</em>2*3</td>
</tr>
</tbody>
</table>

*1 “Memory Stick Duo”, “MagicGate Memory Stick Duo” and “Memory Stick PRO Duo” are equipped with MagicGate functions. MagicGate is copyright protection technology that uses encryption technology. Data recording/playback that requires MagicGate functions cannot be performed with this camera.

*2 Supports high-speed data transfer using a parallel interface.

*3 640(Fine) size movies can be recorded.

- This camera is compatible with “Memory Stick Micro” (“M2”). “M2” is the abbreviated product name for a “Memory Stick Micro”.
- A “Memory Stick Duo” formatted with a computer is not guaranteed to operate with this camera.
- Data read/write speeds differ depending on the combination of the “Memory Stick Duo” and the equipment used.

Some “Memory Stick Duo” cards do not have a write-protect switch. On “Memory Stick Duo” with this switch, the position and shape may vary depending on the “Memory Stick Duo”.

- Do not remove the “Memory Stick Duo” while reading or writing data.
- Data may be corrupted in the following cases:
  - When the “Memory Stick Duo” is removed or the camera is turned off during a read or write operation
  - When the “Memory Stick Duo” is used in locations subject to static electricity or electrical noise
- We recommend backing up important data.
- Do not press down hard when you write down on the memo area.
- Do not attach a label on the “Memory Stick Duo” itself nor on a Memory Stick Duo Adaptor.
- When you carry or store the “Memory Stick Duo”, put it in the case supplied with it.
- Do not touch the terminal section of the “Memory Stick Duo” with your hand or a metal object.
- Do not strike, bend or drop the “Memory Stick Duo”.
- Do not disassemble or modify the “Memory Stick Duo”.
- Do not expose the “Memory Stick Duo” to water.
- Do not leave the “Memory Stick Duo” within the reach of small children. They might accidentally swallow it.
On the “Memory Stick”

- Do not use or store the “Memory Stick Duo” under the following conditions:
  - High temperature locations such as the hot interior of a car parked in direct sunlight
  - Locations exposed to direct sunlight
  - Humid locations or locations with corrosive substances present

Notes on using the Memory Stick Duo Adaptor (not supplied)

- To use a “Memory Stick Duo” with a “Memory Stick” compliant device, be sure to insert the “Memory Stick Duo” into a Memory Stick Duo Adaptor. If you insert a “Memory Stick Duo” into a “Memory Stick” compliant device without a Memory Stick Duo Adaptor, you might not be able to remove it from the device.
- When inserting a “Memory Stick Duo” into a Memory Stick Duo Adaptor, make sure the “Memory Stick Duo” is inserted facing in the correct direction, then insert it all the way in. Incorrect insertion may result in a malfunction.
- When using a “Memory Stick Duo” inserted into a Memory Stick Duo Adaptor with a “Memory Stick” compliant device, make sure that the Memory Stick Duo Adaptor is inserted facing the correct direction. Note that improper use may damage the equipment.
- Do not insert a Memory Stick Duo Adaptor into a “Memory Stick” compliant device without a “Memory Stick Duo” attached. Doing so may result in malfunction of the unit.

Notes on using “Memory Stick PRO Duo” (not supplied)

“Memory Stick PRO Duo” with a capacity up to 8 GB have been confirmed to operate properly with this camera.

Notes on using “Memory Stick Micro” (not supplied)

- To use a “Memory Stick Micro” with this camera, be sure to insert the “Memory Stick Micro” into a “Memory Stick Micro” size “M2” adaptor. If you insert a “Memory Stick Micro” into the camera without a “Memory Stick Micro” size “M2” adaptor, you might not be able to remove it from the camera.
- Do not leave the “Memory Stick Micro” within the reach of small children. They might accidentally swallow it.
On the battery pack

On charging the battery pack
We recommend charging the battery pack in an ambient temperature of between 10°C to 30°C (50°F to 86°F). You may not be able to efficiently charge the battery pack outside of this temperature range.

Effective use of the battery pack
• Battery performance decreases in low temperature surroundings. So, the time that the battery pack can be used is shorter in cold places. We recommend the following to ensure longer battery pack use:
  – Put the battery pack in a pocket close to your body to warm it up, and insert it in your camera immediately before you start shooting.
• The battery pack will run out quickly if you use the flash or zoom frequently.
• We recommend having spare battery packs handy for two or three times the expected shooting time, and making trial shots before taking the actual shots.
• Do not expose the battery pack to water. The battery pack is not water-resistant.
• Do not leave the battery pack in extremely hot places, such as in a car or under direct sunlight.

How to store the battery pack
• If the battery pack is not to be used for a long time, fully charge it and then fully use it up once a year on your camera before storing the battery pack in a dry, cool place. Repeat this charging and using up once a year to maintain the battery pack’s function.
• To use the battery pack up, leave your camera in slide show (page 46) playback mode until the power goes off.
• To prevent staining the terminal, short-circuiting, etc., be sure to use a supplied battery case when carrying and storing.

On battery life
• The battery life varies according to how it is stored and the operating conditions and environment in which each battery pack is used.

• The battery life is limited. Battery capacity decreases little by little as you use it more and more, and as time passes. If the battery operating time seems shortened considerably, a probable cause is that the battery pack has reached the end of its life. Buy a new battery pack.
On the battery charger

- Do not charge any other battery pack other than the NP-BG type battery packs in the battery charger supplied with your camera. Batteries other than the specified kind may leak, overheat, or explode if you attempt to charge them, posing a risk of injury from electrocution and burns.

- Remove the charged battery pack from the battery charger. If you leave the charged battery pack in the charger, battery life may be shortened.

- When the CHARGE lamp flashes, this may indicate a battery error or that a battery pack other than the specified type have been inserted. Check that the battery pack is the specified type. If the battery pack is the specified type, remove the battery pack, replace it with new one or another one and check if the battery charger operates correctly. If the battery charger operates correctly, a battery error may have occurred.

- If the battery charger is dirty, charging may not be performed successfully. Clean the battery charger with dry cloth, etc.
A
Adjusting EV .................. 39
AE/AF lock indicator ....... 42
AF Illuminator ................. 63
AF lock .......................... 42
AF Mode .......................... 64
AF range finder frame ....... 41
Aperture ........................ 8
Auto adjustment mode ...... 20
Auto Focus ..................... 7
Auto Orientation .............. 65
Auto Review .................... 65

B
B & W ............................... 38
Battery charger ............... 114
Battery pack ................... 113
Beach mode ..................... 33
Beep ................................ 60
Blur .................................. 7
Burst ................................. 37

C
Cable for multi-use terminal .... 68, 75, 92
Center AF ......................... 41
Center-weighted metering .... 40
Change REC. Folder .......... 58
Clock Settings ................ 66
Close Focus ..................... 22
Cloudy ............................. 43
Color ................................ 9
Color Mode ...................... 38
COMPONENT .................. 61
Computer ....................... 71
Copying images .......... 74, 88
Copy ................................. 58
Copying images to your computer .......... 74
Create REC. Folder .......... 57
Cross Filter ..................... 50
Data disc ......................... 84
Date ........................... 85, 99, 104
Daylight ......................... 43
Delete
Format ......................... 57, 59
Digital Zoom .................. 64
DirectX .......................... 64
DISP ............................... 72
Download Music .............. 87
DPOF ............................... 53, 94
Exposure ......................... 8, 18
Extension ....................... 80
Face Detection .................. 36
File name ........................ 79
File storage destination ...... 79
Fireworks mode ............... 33
Fisheye Lens .................... 50
Flash (White balance) ...... 44
Flash Auto ....................... 21
Flash forced off .............. 21
Flash forced on ............... 21
Flash Level ...................... 44
Flash mode ...................... 21
Fluorescent ..................... 43
Focus .............................. 7, 41
Focus preset ................. 42
Folder
Changing ....................... 58
Creating ......................... 57
Selecting ....................... 54
Format ......................... 57, 59
Format Music .................. 87
Function Guide ................ 60
Grid Line ......................... 63
HD Output Adaptor Cable ... 69
High Sensitivity mode ....... 33
Hi-Speed Shutter mode ...... 33
Histogram ....................... 18
Holding the camera .......... 7, 20
HOME
Items ......................... 29
Screen ......................... 28
Identifying parts ............ 12
Image file storage destinations and file names ...... 79
Image quality .................. 10
Image size ...................... 10
Incandescent .................. 43
Index Display .................. 46
Index screen ................. 25
Index

Indicator................................14
Initialize.................................60
Install....................................73
Internal memory ...................19
Internal Memory Tool...........59
ISO....................................8, 39

J
JPG .......................................79

L
Landscape mode...................33
Language Setting.................67
LCD Screen ..........................18

M
Macintosh computer ..........88
  Recommended environment........88
Macro..................................22
Main Settings 1...............60
Main Settings 2...............61
Manage Memory
  Internal Memory Tool ...59
  Memory Stick Tool .......57
Map View ............................84
Mass Storage .................61
“Memory Stick Duo” .......111
Memory Stick Tool ..........57
Menu
  Items.................................31
  Shooting ..........................35
  Viewing ............................49
Metering Mode .................40
Monitor ............................64
MPG ..................................79
Multi AF ...........................41
Multi connector .............13
Multi-pattern metering ......40
Multipoint AF .................41
Music ..................................47
Music Tool ..........................87
Music Transfer ...............87, 89

N
Natural ................................38
NR slow shutter...............15
NTSC .................................62

O
Optical zoom.....................21, 64
OS ...................................72, 88
Overexposure ....................8

P
PAL ....................................62
Partial Color ..........................50
PC .....................................71
PictBridge .........................61, 91
Picture Motion Browser ......81
Pixel ..................................10
Playback zoom .................24
Precision digital zoom .......64
Pressing halfway down ......7
Print ..................................53, 90
Print order mark ..............94
Printing at a shop ..........94
Printing directly ..........91
Printing, Other ..............29
Protect ............................52

R
REC Mode ............................37
Red Eye Correction .............51
Red Eye Reduction ..............45
Retouch ..............................49
Rewind/Fast forward ..........24
Rotate ..............................53

S
Scene Selection ...............33, 35
Screen
  Changing the display.....18
  Indicator .........................14
  LCD backlight................18
Self-diagnosis display ......107
Self-timer .........................23
Sepia .................................38
Settings
  Main Settings 1 ..........60
  Main Settings 2 ..........61
  Shooting Settings 1 ....63
  Shooting Settings 2 ....65
SETUP ...............................45
Shooting menu ........................35
Shooting Settings 1 ..........63
Shooting Settings 2 ..........65
Shutter speed .................8
Single ..............................64
Single Image ..........................46
Slide Show ..........................46, 49
Slow synchro .....................21
Smart zoom .......................64
Snow mode ..........................33
Soft Focus .........................49
Soft Snap mode ...............33
Software ............................73, 81, 87
Spot AF ..............................41
Spot metering ..................40
Spot metering cross hairs ....40
SteadyShot ......................45

T
Trimming .........................51
Troubleshooting ....................96
TV .....................................68
Twilight mode ......................33
Twilight Portrait mode .......33
Index

U
Underexposure ..................... 8
USB Connect ....................... 61

V
VGA .................................. 10
Video Out ........................... 62
View Images ........................ 29
Viewing menu ....................... 49
Vivid .................................. 38
Volume ............................... 24

W
Warning indicators and messages ............... 107
White Bal ............................. 43
White balance ........................ 43
Windows computer ................. 71
    Recommended environment ............. 72
Write-protect switch .............. 111

Z
Zoom .................................. 21
Notes on the License

“C Library,” “Expat,” and “zlib” software are provided in your camera. We provide this software based on license agreements with their owners of copyright. Based on requests by the owners of copyright of these software applications, we have an obligation to inform you of the following. Please read the following sections. Read “license1.pdf” in the “License” folder on the CD-ROM. You will find licenses (in English) of “C Library,” “Expat,” and “zlib” software.

On GNU GPL/LGPL applied software

The software that is eligible for the following GNU General Public License (hereinafter referred to as “GPL”) or GNU Lesser General Public License (hereinafter referred to as “LGPL”) are included in the camera. This informs you that you have a right to have access to, modify, and redistribute source code for these software programs under the conditions of the supplied GPL/LGPL. Source code is provided on the web. Use the following URL to download it. http://www.sony.net/Products/Linux/ We would prefer you do not contact us about the contents of source code. Read “license2.pdf” in the “License” folder on the CD-ROM. You will find licenses (in English) of “GPL,” and “LGPL” software. To view the PDF, Adobe Reader is needed. If it is not installed on your computer, you can download it from the Adobe Systems web page: http://www.adobe.com/
Additional information on this product and answers to frequently asked questions can be found at our Customer Support Website.

http://www.sony.net/